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List of Abbreviations

CAF coherent adaptive focusing
FFT fast Fourier transform
MFC Microsoft Foundation Class
ML material loss
SDK software development kit
TCG time-corrected gain
USB universal serial bus
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Important Information — Please Read Before Use

Intended Use

FocusPC is a software program designed for FOCUS PX instruments used in 
nondestructive inspections on industrial and commercial materials.

Instruction Manual

This instruction manual contains essential information on how to use this Evident 
product safely and effectively. Before using this product, thoroughly review this 
instruction manual. Use the product as instructed.

Keep this instruction manual in a safe, accessible location.

Software Compatibility

FocusPC is only compatible with FOCUS PX instruments. For a list of models, see 
Table 1 on page 22.

Always use equipment and accessories that meet Evident specifications. Using 
incompatible equipment could cause equipment malfunction and/or damage, or 
human injury.

CAUTION
Important Information — Please Read Before Use 9
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Safety Symbols

The following safety symbols might appear on the instrument and in the instruction 
manual:

 General warning symbol
This symbol is used to alert the user to potential hazards. All safety messages that 
follow this symbol shall be obeyed to avoid possible harm or material damage.

 Shock hazard caution symbol
This symbol is used to alert the user to potential electric shock hazards. All safety 
messages that follow this symbol shall be obeyed to avoid possible harm.

Safety Signal Words

The following safety symbols might appear in the documentation of the instrument:

The DANGER signal word indicates an imminently hazardous situation. It calls 
attention to a procedure, practice, or the like that if not correctly performed or 
adhered to will result in death or serious personal injury. Do not proceed beyond a 
DANGER signal word until the indicated conditions are fully understood and met.

The WARNING signal word indicates a potentially hazardous situation. It calls 
attention to a procedure, practice, or the like that if not correctly performed or 
adhered to could result in death or serious personal injury. Do not proceed beyond a 
WARNING signal word until the indicated conditions are fully understood and met.

DANGER

WARNING
Important Information — Please Read Before Use10
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The CAUTION signal word indicates a potentially hazardous situation. It calls 
attention to a procedure, practice, or the like that if not correctly performed or 
adhered to may result in minor or moderate personal injury, material damage, 
particularly to the product, destruction of part or all of the product, or loss of data. Do 
not proceed beyond a CAUTION signal word until the indicated conditions are fully 
understood and met.

Note Signal Words

The following note signal words could appear in the documentation of the 
instrument:

The IMPORTANT signal word calls attention to a note that provides important 
information, or information essential to the completion of a task.

The NOTE signal word calls attention to an operating procedure, practice, or the like, 
which requires special attention. A note also denotes related parenthetical 
information that is useful, but not imperative.

The TIP signal word calls attention to a type of note that helps you apply the 
techniques and procedures described in the manual to your specific needs, or 
provides hints on how to effectively use the capabilities of the product.

Warranty Information

Evident guarantees your Evident product to be free from defects in materials and 
workmanship for a specific period, and in accordance with conditions specified in the 
Terms and Conditions available at https://www.olympus-ims.com/en/terms/.

CAUTION

IMPORTANT

NOTE

TIP
Important Information — Please Read Before Use 11
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The Evident warranty only covers equipment that has been used in a proper manner, 
as described in this instruction manual, and that has not been subjected to excessive 
abuse, attempted unauthorized repair, or modification.

Inspect materials thoroughly on receipt for evidence of external or internal damage 
that might have occurred during shipment. Immediately notify the carrier making the 
delivery of any damage, because the carrier is normally liable for damage during 
shipment. Retain packing materials, waybills, and other shipping documentation 
needed in order to file a damage claim. After notifying the carrier, contact Evident for 
assistance with the damage claim and equipment replacement, if necessary.

This instruction manual explains the proper operation of your Evident product. The 
information contained herein is intended solely as a teaching aid, and shall not be 
used in any particular application without independent testing and/or verification by 
the operator or the supervisor. Such independent verification of procedures becomes 
increasingly important as the criticality of the application increases. For this reason, 
Evident makes no warranty, expressed or implied, that the techniques, examples, or 
procedures described herein are consistent with industry standards, nor that they 
meet the requirements of any particular application.

Evident reserves the right to modify any product without incurring the responsibility 
for modifying previously manufactured products.

Technical Support

Evident is firmly committed to providing the highest level of customer service and 
product support. If you experience any difficulties when using our product, or if it 
fails to operate as described in the documentation, first consult the user’s manual, and 
then, if you are still in need of assistance, contact our After-Sales Service. To locate the 
nearest service center, visit the Service Centers page on the Evident Scientific Web site.
Important Information — Please Read Before Use12
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Introduction

FocusPC is a powerful and versatile ultrasonic and phased array software designed to 
be the centerpiece of automated inspection systems (Figure i-1 on page 13). Its 
flexibility and high-end features enable you to perform inspections that meet the most 
stringent inspection criteria and ever increasing industry requirements.

Figure i-1  Example of a fully automated inspection system1

1. Photo courtesy of SCLEAD.
Introduction 13
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FocusPC is a flexible software designed to perform fast and precise inspections on 
simple or complex-shaped parts. In order to achieve this, FocusPC can drive one or 
many FOCUS PX acquisition instruments.

FocusPC offers a flexible graphical user interface allowing you to customize, save, and 
retrieve layouts containing various views. This manual provides instruction on how 
to use FocusPC to its full advantage to facilitate your UT inspections.

Using FocusPC with the FOCUS PX

To build systems that reach optimal inspection speeds and detectability, FocusPC is 
best used with the FOCUS PX (Figure i-2 on page 14). The FOCUS PX is a high speed 
acquisition instrument that can be used to drive multiple phased array and 
conventional UT probes; its features are fully exploited within the FocusPC software.

Figure i-2  FocusPC / FOCUS PX system example

Scalability is also a major asset, allowing the adjustment of the number of FOCUS PX 
instruments used for a system in order to reach the expected system performances 
(Figure i-3 on page 15).

FOCUS PX Phased array probesFocusPC
Introduction14
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Figure i-3  FocusPC / FOCUS PX system diagram

Building Automated Inspection Systems with the FocusPC SDK

To allow the automation of systems built with FocusPC, two software development 
kits (SDK) were developed by Evident. These SDKs allow you to customize inspection 
systems and upgrade from operator-driven to fully automated systems:

• FocusControl is an SDK that includes program samples and the full source code. 
It allows you to create custom programs that you can use to control FocusPC, or 
create user interfaces that are dedicated to specific applications (Figure i-4 on 
page 16). For more details, see “FocusControl SDK” on page 17.

FOCUS PX Phased array probesFocusPC
Introduction 15
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Figure i-4  Example of a system using FocusControl to enable automation

• FocusData is another SDK, which also includes program samples and the full 
source code. FocusData lets you create custom programs that you can use to 
extract raw inspection data for custom data processing and presentation 
(Figure i-5 on page 16). For more details, see “FocusData SDK” on page 18.

Figure i-5  Example of a custom data presentation using FocusData

FocusPC + 
FOCUS PX

Custom automation program 
(using FocusControl)

Custom data program (using FocusData)

FocusPC data file
Introduction16
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FocusControl SDK

Phased array inspection systems are often automated to reduce cycle time and 
improve system performance. In order to achieve this, custom programs can be built 
to communicate with FocusPC and control the inspection process.

The FocusControl SDK establishes the link between FocusPC and custom programs, 
giving a direct control of the inspection process. It also allows the creation of user-
defined interfaces that can be built to make the system more convenient to use and 
optimize the inspection workflow.

FocusControl is compatible with the C++, C#, VB, MATLAB, and LabView 
programming languages and comes with fully developed sample programs provided 
with the complete source code (Figure i-6 on page 18).

Refer to the FocusControl User’s Manual for a complete description.
NOTE
Introduction 17
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Figure i-6  Sample program provided with FocusControl

FocusData SDK

FocusData enables exporting of raw A-scan and C-scan data from FocusPC data files 
to Microsoft Excel, MATLAB, or any other external program. The exported data can 
then be used to perform processing algorithms and create customized data 
representations (Figure i-7 on page 19).

FocusData is compatible with the C++, C#, VB, MATLAB, and LabView programming 
languages and comes with fully developed sample programs provided with the 
complete source code (refer to the FocusData User’s Manual for a complete 
description).
Introduction18
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Figure i-7  Sample program provided with FocusData
Introduction 19
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1. Getting Started

This chapter contains information that enables you to quickly begin using FocusPC.

1.1 Minimum Computer Requirements

The minimum computer requirements for FocusPC software are as follows:

• CPU: Intel Core i7 or Xeon E3
• RAM memory: 16 GB (DDR3 or better)
• Data storage drive: SSD
• Network adaptor: Gigabit Ethernet card — dedicated to the acquisition 

instrument (for acquisition). The computer needs a second network adaptor if you 
want to simultaneously connect it to a local area network and to a data acquisition 
instrument.

• 1280 × 1024 or higher display adaptor and monitor resolution
• One USB port for the HASP security hardware key
• A keyboard and a pointing device
• Microsoft windows 10

You can install FocusPC on a drive other than the drive used for Windows. In that 
case, the FocusPC installer still requires 150 MB of the drive where Windows resides, 
to install the hardware security key driver, the Direct X updates, the Windows 
temporary installation, and the MFC (Microsoft Foundation Class) files.

IMPORTANT
Getting Started 21
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In this document, FocusPC screen captures were taken on a computer running 
Windows 10. The look of the screen captures could differ if you are using FocusPC on 
a computer running another operating system.

For most examples presented in this document, FocusPC was arbitrarily configured to 
use the metric measurement units (refer to the FocusPC Advanced User’s Manual to find 
how to change measurement units).

1.2 Compatible Data Acquisition Instruments

FocusPC operates with Evident ultrasonic instruments to acquire data in Inspection 
mode and to analyze data files created with these instruments. Table 1 on page 22 
provides the list of the compatible instruments.

1.3 Connecting a FOCUS PX to a Computer and Setting Connection 
Parameters

Whenever you are connecting a FOCUS PX unit to a computer or switch, ensure that 
you use a category 5e or higher Ethernet cable.

Table 1  Evident data acquisition instruments compatible with FocusPC 

Family Models

FOCUS PX FPX-UT4 [Q7750033]— 4-channel conventional UT

FPX-1664PR [Q7750034] — 16:64 pulser receiver (PR) 
phased array

FPX-16128PR [Q7750035] — 16:128 pulser receiver (PR) 
phased array

FPX-32128PR [Q7750036] — 32:128 pulser receiver (PR) 
phased array

NOTE
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To connect all cables on a FOCUS PX

 Connect all required cables to the FOCUS PX unit. The schematic below shows 
how to connect multiple units (Figure 1-1 on page 23). If you only use one unit, 
connect only the first one without a Sync Out cable.

Figure 1-1  Multiple unit connection

Whenever you use a switch, ensure that it supports a gigabit connection and jumbo 
packets.

For optimal performances, the switch should be configured to allow the jumbo 
packet. The MTU should be set at 9198.

To check your switch or computer setting

1. Open the Command Prompt.
2. Ping the FOCUS PX unit’s IP address and add -f -l 8972 at the end (Figure 1-2 on 

page 24).

Encoders

Focus PX unit #1
QC-xxxxxx
(rear panel)

Inputs

Alarms

Focus PX unit #2
QC-xxxxxx
(rear panel)

Focus PX unit #3
QC-xxxxxx
(rear panel)

I/O

Power

Ethernet

Digital Out

Power Power

Ethernet Ethernet

I/O I/O

Digital Out Digital OutSync In
Sync OutSync Out

Sync OutSync In

Sync In

Switch

Port 1

Port 2

Port 3

Port 4

Port 5

Computer

1 Gbit Ethernet Port

NOTE
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Figure 1-2  Command Prompt —jumbo packet

If your Ethernet card or switch are not jumbo packet compatible or not set properly, 
you will get a result as shown in Figure 1-3 on page 24.

Figure 1-3  Command Prompt — no jumbo packet

You are now able to use the Configuration Tool to validate your connections.
Chapter 124
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1.4 Installing FocusPC

The installation of FocusPC is simple.

To install FocusPC

1. On the computer on which you want to install FocusPC, log on with a user 
account that has administrator rights.

2. Run the FocusPC installer program from the Evident distribution key or website.
3. Follow the on-screen FocusPC installer wizard steps.

The wizard installs FocusPC, the Calculator, and the FOCUS PX Configuration 
Tool.

4. Disable the sleep mode on the computer to prevent a connection loss with the 
data acquisition unit:
a) On the taskbar, click Search, type Edit Power Plan, select Edit Power Plan.
b) In the dialog box Edit Plan Settings, set Turn off the display and Put the 

computer to sleep both to Never (Figure 1-4 on page 25).
c) Click Save changes.

Figure 1-4  Edit Plan Settings dialog box
Getting Started 25
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If you use a third-party firewall on the computer running FocusPC, follow the 
instructions in “To add rules for a firewall” on page 30. The FocusPC installer 
configures the Windows firewall to allow communication between the FOCUS PX 
acquisition unit and the FocusPC and FOCUS PX Configuration Tool programs.

1.5 Using the FOCUS PX Configuration Tool

The FOCUS PX Configuration Tool is included with FocusPC and is used to configure 
the connection of your FOCUS PX acquisition unit and the network card.

To ensure that the Ethernet card settings are correct

1. Open the list of network connections in the Control Panel, and identify the 
connection used to connect to the FOCUS PX unit (Figure 1-5 on page 26).

Figure 1-5  Network connections

NOTE
Chapter 126
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2. Right-click the network connection used to connect to the FOCUS PX unit, and 
then click Properties (Figure 1-6 on page 27).

Figure 1-6  Selecting Properties

3. On the Networking tab, click Configure (Figure 1-7 on page 28).
Getting Started 27
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Figure 1-7  Selecting Configure

4. On the Advanced tab, in the Property list, select either Jumbo Packet or Jumbo 
Frame (Figure 1-8 on page 29).

5. In the Value list, select 9014 Bytes.
Chapter 128
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Figure 1-8  Settings on the Advanced tab

6. On the Advanced tab, select Speed & Duplex, and then select 1.0 Gbps Full 
Duplex (Figure 1-9 on page 30).
Getting Started 29
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Figure 1-9  Speed & Duplex property

7. Click OK.

To add rules for a firewall

It is recommended to turn off your computer’s firewall and antivirus protection. If 
you do not turn off your firewall and antivirus protection, you must add rules to 
allow communication between your computer and the FOCUS PX unit. The 
procedure below shows an example of adding rules in Windows Defender. The 
procedure may differ if you have a different firewall and antivirus protection.

1. On the taskbar, click Search, locate your firewall program, then select Advanced 
Settings.

2. In the Windows Defender Firewall with Advanced Security dialog box, select 
Inbound Rules, and then select New Rule (Figure 1-10 on page 31).

NOTE
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Figure 1-10  Windows Defender Firewall with Advanced Settings dialog box — 
Example

3. In the New Inbound Rule Wizard dialog box, select Port (Figure 1-11 on 
page 32).
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Figure 1-11  New Inbound Rule Wizard dialog box— Port

4. Click Next.
5. In the New Inbound Rule Wizard dialog box, select the protocols and ports to 

which the rule applies (Figure 1-12 on page 33).
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Figure 1-12  New Inbound Rule Wizard dialog box — Protocol and Ports

6. Click Next.
7. Configure the port with the parameters shown in Figure 1-13 on page 34, 

Figure 1-14 on page 34, and Figure 1-15 on page 35.
Getting Started 33
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Figure 1-13  Protocol type — inbound rule TCP 21 and UDP 67

 

Figure 1-14  Protocol type — outbound rule ICMPv4 and TCP
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Figure 1-15  Protocol type — outbound rule UDP 68

8. Click OK.

To configure the FOCUS PX connection

1. Right-click the desktop icon ( ), and select Run as administrator.
Getting Started 35
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Figure 1-16  FOCUS PX Configuration Tool (no connected devices)

2. In the FOCUS PX Configuration Tool dialog box, click Configure Network Card.
3. In the Network Configuration dialog box, select the network card that will be 

used to communicate with the FOCUS PX unit, and then click Configure 
(Figure 1-17 on page 36).

Figure 1-17  Network configuration dialog box

If the network connection is already being used for another device, a message 
appears to inform you that an alternative IP address will be assigned (Figure 1-18 
on page 37).
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Figure 1-18  IP Address conflict dialog box

4. Turn on all FOCUS PX units.
5. In the FOCUS PX Configuration Tool dialog box, type the serial number of the 

first master FOCUS PX unit that is connected to the Ethernet card (Figure 1-19 on 
page 37).
The serial number is located on the back of the FOCUS PX unit.

Figure 1-19  FOCUS PX Configuration Tool (1 device)

6. If you use more than one FOCUS PX unit, repeat the enter step of the serial 
number on the next entry (Figure 1-20 on page 38). Ensure that the order of the 
units is the same as the synchronization connection (see “Connecting a 
FOCUS PX to a Computer and Setting Connection Parameters” on page 22).
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Figure 1-20  FOCUS PX Configuration Tool (3 devices)

7. Click Apply.

To troubleshoot the connection

 Click Troubleshooting to view a list of possible causes of connection problems, 
and follow the instructions provided (Figure 1-21 on page 39).
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Figure 1-21  Troubleshooting dialog box example

1.6 FocusPC Editions

FocusPC is available in three editions:

Inspection
A full-featured mode providing all the inspection and analysis functions. With 
the FocusPC Inspection edition license, you can also choose to start the other 
FocusPC editions (see “Starting FocusPC” on page 42 for details).

Analysis
Provides all analysis functions but no inspection functions.

FocusPC Viewer
A free viewer that allows you to visualize FocusPC data files.

When you start up the software, you need to select which FocusPC edition you want 
to run (Figure 1-22 on page 40).
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Figure 1-22  Startup Selection dialog box

The About FocusPC dialog box, accessed by selecting Help > About, reports which 
edition of FocusPC is currently running (Figure 1-23 on page 40).

Figure 1-23  About FocusPC dialog box indicating the FocusPC edition

1.7 Security Hardware Key

To operate, FocusPC needs to detect a HASP security hardware key connected to the 
computer. The HASP security USB hardware key supplied with your FocusPC copy 
contains the authorization code needed to operate the FocusPC edition that you 
purchased.

Edition currently
running
Chapter 140



DMTA-20092-01EN, Rev. G, September 2022
Before starting FocusPC, connect the HASP hardware key (Figure 1-24 on page 41) to 
the USB port of your computer.

Figure 1-24  HASP security hardware key

When you start FocusPC with no security hardware key connected to the computer, 
FocusPC Viewer is the only enabled edition in the Startup Selection dialog box 
(Figure 1-25 on page 41).

Figure 1-25  Startup Selection dialog box with no security hardware key

If you disconnect the security hardware key while FocusPC is running, the message 
shown in Figure 1-26 on page 42 appears 30 seconds later. After clicking OK, when 
needed, FocusPC proposes to save unsaved data, and then closes.
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Figure 1-26  Missing hardware key message box

When you purchase both the Inspection and Analysis editions of FocusPC, two 
security hardware keys are delivered, one for each edition.

1.8 Starting FocusPC

FocusPC operates with or without a FOCUS PX. When you use FocusPC without an 
acquisition instrument, you can only perform analysis tasks on previously saved data 
files.

To start FocusPC

1. Connect the security hardware key to the appropriate port of the computer. 
FocusPC needs to detect the security hardware key to operate, regardless of 
whether or not it is connected to an acquisition instrument.

2. Turn on the computer and wait for Windows to complete its starting process. Do 
not start FocusPC yet.

3. Connect the data acquisition instrument to the appropriate network adaptor of 
the computer, and then start it (see “Connecting a FOCUS PX to a Computer and 
Setting Connection Parameters” on page 22 for a FOCUS PX).

4. Start FocusPC as follows:

 Double-click the FocusPC icon  on the Windows desktop.

OR
Click Start > All Programs > Evident NDT > FocusPC n.nn on the Windows 
taskbar.
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5. In the Startup Selection dialog box that appears (Figure 1-27 on page 43), click 
the button associated with the desired FocusPC edition.

Figure 1-27  Startup Selection dialog box

If you do not want the Startup Selection dialog box to appear each time you start 
FocusPC, select the Do not show next time check box.

To reactivate the Startup Selection dialog box, select File > Preferences > General 
Settings tab in FocusPC, and then clear the Startup Selection check box under Dialog 
Bypass.

The FocusPC splash screen briefly appears, indicating that the application is 
starting up.

6. When you start the Inspection edition, the Select Device Configuration dialog 
box appears (Figure 1-28 on page 44). In the dialog box, do one of the following:
 Select the acquisition instrument or instruments that you want to include in 

your configuration, and then click OK.

TIP
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With its multipod capability, FocusPC can acquire data from up to four FOCUS PX 
instruments in parallel (up to four active instruments, with an additional [fifth] 
passive instrument), offering up to a fourfold increase in acquisition speed.

OR
When your computer is not connected to an acquisition instrument, click 
Work Offline to use FocusPC only in Analysis mode. In this case, Setup mode 
and Inspection mode will be unavailable.

Figure 1-28  Example of the Select Device Configuration dialog box

The list in the Select Device Configuration dialog box is empty when FocusPC fails 
to detect any hardware devices either because supported acquisition instruments are 
not connected, are not turned on, or are not correctly installed. Refer to the FocusPC 
Advanced User’s Manual for troubleshooting information.

NOTE

NOTE
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7. In the Configuration Selection dialog box that appears (Figure 1-29 on page 45), 
select one of the following setup loading options, and then click OK.
Open the last configuration

Select this option to load the last configuration used, whose name is indicated 
in the box below. By default, the box indicates the name of the default 
configuration (Default_PA.fps, Default_UT.fps, and more).

Open an existing configuration
Select this option to access the Open dialog box. You can use this dialog box 
to browse through the folders and choose a configuration file (with the file 
name extension .fps).

Create a new configuration
Select this option to start a new configuration from a default configuration.

Figure 1-29  Configuration Selection dialog box

A configuration file (.fps) is a complete description of the FocusPC workspace. The 
file includes the acquisition instrument hardware setup and the FocusPC layout 
environment.

If you click Cancel, the default configuration loads (Default_PA.fps for a phased 
array instrument or Default_UT.fps for a UT conventional instrument).
After the selected setup is loaded, the FocusPC window appears.

NOTE
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2. User Interface

This chapter details FocusPC user interface elements.

2.1 FocusPC User Interface and Software Principles

FocusPC provides features needed to perform nondestructive inspections based on 
ultrasonic technology. It combines setup, inspection, and analysis functions in one 
software package. FocusPC can also be used in a stand-alone mode to analyze 
previously acquired data.

The FocusPC user interface (Figure 2-1 on page 48) provides toolbars and menus for 
quick access to main commands. Using FocusPC, you can conveniently present data 
imaging in multiple simultaneous views, such as in the example in Figure 2-1 on 
page 48.
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Figure 2-1  FocusPC user interface example

Data views

A data view is a visual representation of an inspection. You can create several types of 
views and display them simultaneously to visualize different aspects of your 
inspection.

Splitting data views

You can subdivide a data view into multiple sections. The split sections have the 
advantage of being easily resized while maintaining the “tiled” nature of the various 
views.

The data views can be user defined to contain any of the possible view types 
generated by FocusPC. For further information concerning the different types of 
views, see “Data View Types” on page 74.

Dashboard Menu bar Toolbar Data views Status bar
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In FocusPC, the data views also offer flexibility for the location of readings: cursor 
positions, statistics, scale settings, etc. These fields can be dynamically placed and 
customized within any view. For further information concerning the readings, see 
“Working with the Readings” on page 135.

Layout

A layout is a complete set of display-related settings. You can save and load a layout 
to quickly return to a desired view configuration. Layout configurations are included 
in data files so that recorded data can be viewed through the original layouts that 
existed at data-recording time, or through the current system layouts.

Template layouts are also provided as a reference for the most common inspection 
types. A menu on the Dashboard provides quick access to existing template layouts 
installed in FocusPC (see “Working with Layouts” on page 132 for more information 
on using layouts).

Setup

A setup file is a complete set of FocusPC settings that an operator can access while 
using the FocusPC interface. Setup files may contain one or more layouts, and they 
can be saved and restored on demand.

Normally, a setup represents a procedure for a specific application that is to be 
performed with the equipment.

2.2 Component Toolbars

The FocusPC toolbars at the top of the main window contain buttons to initiate 
commands or to access dialog boxes. See Figure 2-2 on page 49 and Table 2 on page 50 
for descriptions of the components available in the toolbars. In the menu under 
Toolbars, you can show or hide the Advanced Weld and Advanced Aero toolbars by 
selecting or deselecting them in the menu.

Figure 2-2  Component toolbars

Advanced Weld toolbar

Advanced Aero toolbar

Main toolbar
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Table 2  Toolbar buttons 

Icon Component Description

Main toolbar buttons

Dashboard Opens and closes the Dashboard pane, which is 
used to manage groups and inspection sequences

UT settings Opens the UT Settings dialog box, which contains 
the ultrasonic setup parameters

Part and material Opens the Part Definition dialog box, in which 
you define the geometry of flat or cylindrical parts

Scan settings Opens the Scan and Mechanical Settings dialog 
box, which is used to define the scan and settings 
for the mechanical scanning system

Split view vertically Divides the active view into two views with the 
same vertical dimension

Split view 
horizontally

Divides the active view into two views with the 
same horizontal dimension

Split view in four Divides the active view into four views with the 
same horizontal and vertical dimensions

Add view content Opens the Contents dialog box, used to select the 
data view types to be displayed in the active pane

Delete view Deletes the active view

View properties Opens the View Properties dialog box, used to 
configure the parameters of the active view

Readings 1 Toggles the display of information group 1 in the 
active view (by default, readings related to 
reference cursors)

Readings 2 Toggles the display of information group 2 in the 
active view (by default, readings related to 
measurement cursors)
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Readings 3 Toggles the display of information group 3 in the 
active view (by default, readings related to 
reference and measurement cursors)

Readings 4 Toggles the display of information group 4 in the 
active view (by default, readings related to the 
Zone tool)

PA calibration Calibrates all phased array beams

Signal envelope Toggles the activation of the Envelope mode for 
the A-scan view

Firing sequencer Modifies the order in which the ultrasonic beams 
are fired

Zoom tool Select and zoom in a specific region on a view

Zone tool Select a region on a top, side, end, or C-scan view 
by clicking and dragging
Tip: When the Zone tool is not selected, press and 
hold the CTRL key, and then click and drag on a 
view to perform the same task.

C-scan merge Opens the C-Scan Merge dialog box, used to 
perform a C-scan merge of recorded data in 
Analysis mode

Thickness C-scan Opens the Create Thickness C-Scan dialog box, 
which can be used to create thickness C-scan data 
by performing subtractions on data originating 
from two gates 

Soft gain tool Opens the Gain Information dialog box, used to 
set the software gain and dynamically change 
color palette maximum and minimum values

Indication table Opens the Indication Table dialog box, used to 
manage indication information and create reports

Table 2  Toolbar buttons (continued)

Icon Component Description
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2.3 Dashboard Dialog Box

The Dashboard is where you pilot the operations in FocusPC. The Dashboard 
contains the mode, group, scan, and layout parameters that you need to define before 
performing an inspection (Figure 2-3 on page 53).

Fast Fourier 
transform

Opens the Fast Fourier Transforms dialog box, 
used to calculate values related to the fast Fourier 
transform (FFT)

Advanced Weld toolbar buttons

Edit weld Opens the Edit Overlays dialog box, in which you 
can rename, relocate, or delete a component

Add weld Opens the Predefined Weld dialog box, in which 
you select a weld type and define its geometry

Automatic 
volumetric merge

Performs a volumetric merge of all focal laws for 
all groups using the default parameters

Automatic 
volumetric merge by 
group

Performs a volumetric merge of all focal laws for 
each corresponding group using the default 
parameters

Volumetric merge Opens the Volumetric Merge dialog box, used to 
perform a volumetric merge of recorded data in 
Analysis mode

TOFD Manager Opens the TOFD Manager dialog box, used to 
analyze time-of-flight diffraction inspection data

Advanced Aero toolbar button

SNR analysis Opens the SNR Analysis Utility dialog box, used 
to compute the signal-to-noise ratio

Table 2  Toolbar buttons (continued)

Icon Component Description
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Figure 2-3  Components of the Dashboard dialog box

2.4 Document Windows

FocusPC allows you to open one or more document windows at a time: a separate 
window for each file that is opened. However, only one setup can be open at a time. 
You can display one or more data views at a time in each window (Figure 2-4 on 
page 54).

Mode button (See “FocusPC Modes” on
page 60.)

Calculator
To define probe, wedge, part, and

calculate beams

Predefined layouts

Acquisition speed

Set signal to reference

Set start and range

Add a new group Delete the currently selected group
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Figure 2-4  Example of a document window containing three views

You can cascade or manually tile multiple windows. You also can add, remove, or 
empty views in a window, using the toolbar. Two or more views appear side by side, 
never overlapping. You activate any view by clicking on it.

2.5 Layouts

In FocusPC, a layout is an organization of two or more views appearing in the 
window. Layouts offer extensive flexibility in how you present your inspection data.

FocusPC offers a set of ten layouts that are available on the Dashboard for quick 
selection (Figure 2-5 on page 55). You can also select one of the layouts on the Layout 
menu. A set of ten layouts is saved in an .rst file.

Title bar
Shows name of data

file and layout.

Views
Data presented in one

of the view types

View border
Click and drag to

resize the view.
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Figure 2-5  Set of ten layouts

2.6 UT Settings Dialog Box

You can click the UT Settings button ( ) on the component toolbar to toggle the 
visibility of the UT Settings dialog box. The UT Settings dialog box contains eight 
basic tabs: General, Gate, TCG, Digitizer, Pulser/Receiver, Position, Alarms, 
Transmitter, and Receiver (Figure 2-6 on page 55). For more details on the different 
tabs of the UT Settings dialog box, refer to the FocusPC Advanced User’s Manual.

Figure 2-6  UT Settings dialog box

Currently selected layout

Set of ten available layouts
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2.7 Scan and Mechanical Settings Dialog Box

Clicking the Scan Settings button ( ) on the component toolbar toggles the 
visibility of the Scan and Mechanical Settings dialog box, which contains four basic 
tabs: Scan, I/O, Encoders, and Data (Figure 2-7 on page 56). For more details on the 
different tabs of the Scan and Mechanical Settings dialog box, refer to the FocusPC 
Advanced User’s Manual.

Figure 2-7  Scan and Mechanical Settings dialog box

2.8 View Properties Dialog Box

Clicking the View Properties button ( ) on the component toolbar toggles the 
visibility of the View Properties dialog box. The Information, Display, Palette, Data 
Source, and Units tabs are available in the View Properties dialog box, depending on 
the data type contained in the active view. For more details on the different tabs of the 
View Properties dialog box, refer to the FocusPC Advanced User’s Manual.

Figure 2-8  View Properties dialog box
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2.9 Docking Dialog Boxes

FocusPC allows you to dock the main dialog boxes on a window border. A docking 
dialog box aligns itself with an edge of the window. By dragging its title bar, you can 
move the docking dialog box anywhere on the screen as a floating dialog box. 
Inversely, you can drag and dock the floating dialog box to one of the window edges 
(Figure 2-9 on page 57).

Figure 2-9  Floating (top) and docking (bottom) of a dialog box

Using the thumbtack function, you can specify if the dialog box remains displayed or 
not when you open other docking dialog boxes. For this purpose, you can click the 
thumbtack icon, located in the upper-left corner of the dialog box, to toggle between 
the two following options:

Double-click the title
bar to dock the dialog

box.

Click to float the dialog
box.
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Tacked option icon ( )
The dialog box remains open when you open other docking dialog boxes.

Untacked option icon ( )
The dialog box closes when you open other docking dialog boxes.
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3. Concepts and Operational Mode

The FocusPC user interface shown in Figure 3-1 on page 59 provides toolbars, 
dockable dialog boxes, a data display, and a status bar.

Figure 3-1  Main elements of the FocusPC user interface

Toolbars

Dockable vertical
dialog box

Window with data
display views

Status bar

Dockable
horizontal dialog

box
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3.1 FocusPC Modes

FocusPC has three modes:

Setup
Mode in which you set up the various hardware and software parameters 
(ultrasonic, scan, and window layout settings). FocusPC starts in Setup mode 
when it is connected to an acquisition instrument.

Inspection
Mode in which you perform data acquisition. Inspection mode is available only 
when FocusPC is connected to an acquisition instrument.

Analysis
Mode in which you carry out analysis and produce reports for recorded data. 
FocusPC starts in Analysis mode when it is not connected to an acquisition 
instrument.

To go from one mode to the another, on the Dashboard, click the mode button 
(Figure 3-2 on page 61). The mode button changes depending on the current mode.
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Figure 3-2  Switching between modes

The status bar, which remains visible below the views, includes a Mode parameter 
that indicates the current mode (Figure 3-3 on page 61).

Figure 3-3  Mode indicated in the status bar

3.2 Groups

In FocusPC, a group is a defined configuration of parameters to generate one or more 
ultrasonic beams using a conventional or phased array probe. A group can pulse and 
receive on the same probe, or you can use two different probes, one to pulse, and the 
other to receive, and a probe can be used by more than one group.

Setup mode
To configure FocusPC for the setup 

and the parts to inspect

Inspection mode
To perform the inspection and 

acquire data

Analysis mode
To analyze the acquired data Dashboard mode button

ModeStatus bar
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Assembling different beams in one group allows you to set the same parameters for 
all the beams at one time. This also allows you to display images built from all beams 
(such as a sectorial scan). Depending on the application, it might be helpful to use 
different settings for different beams (for example, different band-pass filters), 
justifying the creation of one group per beam.

You can create, delete, select, and configure groups on the Dashboard (Figure 3-4 on 
page 62).

Figure 3-4  Group area in the Dashboard

For example, you can create a first phased array group to generate a linear scan, a 
second group to generate a sectorial scan, and then display them concurrently in a 
layout (Figure 3-5 on page 63).

Name of the active group

Add a group Delete a group

Basic A-scan parameters
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Figure 3-5  Example of two scans from two different groups

3.3 Calculator

The Calculator is an Evident software that comes with FocusPC. You start the 

Calculator on the Dashboard by clicking the Calculator button ( ). From FocusPC, 
use the Calculator to specify the probe and wedge used in the inspection, the 
geometry and material of the inspected part, and the beam configuration. The 
Calculator calculates the beams and returns the information to FocusPC.

Refer to the FocusPC Advanced User’s Manual for more details.

3.4 Scans

In FocusPC, you can configure scan parameters and save them as a named scan. 
FocusPC comes with useful predefined scans.

You can edit, delete, or create a scan configuration (including predefined scans) using 
the Scan and Mechanical Settings dialog box (Figure 3-6 on page 64). The scan 
configurations are saved in the hardware setup (.fps) file.

NOTE
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Figure 3-6  Scan tab of the Scan and Mechanical Settings dialog box

The following predefined scans are available:

Free running
Scan where data is acquired at the rate specified under PRF on the Digitizer tab 
of the UT Settings dialog box. The data is recorded at only one position, at the 
origin of the scan and index axes.

Encoded - 1 axis
Scan using one position encoder to determine the position during the acquisition 
along a linear path. The data is recorded at every interval (corresponding to the 
resolution setting) along the path from the start position to the end position of the 
scan axis.

Encoded - 2 axis
Scan using two position encoders to determine the position during the acquisition 
on a bidimensional surface scan. The data is recorded at every interval 
(corresponding to the resolution setting) along the path from the start position to 
the end position of both the scan and index axes.

Inter. clock - 1 axis
Scan using the internal clock (PRF) to determine the position during the 
acquisition along a linear path. The data is recorded at every interval 
(corresponding to the resolution setting) along the path from the start position to 
the end position of the scan axis.

Inter. clock - 2 axis
Scan using the internal clock (PRF) to determine the position during the 
acquisition on a bidimensional surface scan. The data is recorded at every interval 
(corresponding to the resolution setting) along the path from the start position to 
the end position of both the scan and index axes.
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When you modify or delete predefined scans, you can restore them by opening a 
default hardware setup (.fps) file.

3.5 Probe Orientation Conventions

This section describes the conventions used in FocusPC for the probe and the wedge 
orientations relative to the axes.

The probes and wedges are illustrated schematically as shown in Figure 3-7 on 
page 65. The probe element number of a phased array generally increases from the 
back to the front of the probe/wedge assembly.

Figure 3-7  Example of illustration of a probe and a wedge

TIP
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Elements
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Beam direction
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In applications where the probe connector or wire is physically interfering with other 
inspection setup components, you can mount the probe in a reverse position on the 
wedge. To notify FocusPC about this, in the Calculator, select the Reverse primary 
axis check box under the Probe area. The check box is automatically selected when 
you select a reversed wedge model.

The probe skew is defined as the angle between the primary axis of the probe and the 
scan axis. The skew has a value of 0° when the beam direction points parallel to the 
scan axis in the positive direction. The skew angle increases clockwise.

In the example shown in Figure 3-8 on page 67, the angle beam probe is moving on 
the inspected part along the scan axis following a raster scan pattern. The beam 
direction is parallel to the scan axis. Consequently, the probe skew is equal to 0°.

NOTE
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Figure 3-8  Raster scan plate inspection with 0° probe skew

In the example shown in Figure 3-9 on page 68, the probe is moving on the inspected 
part along the scan axis. The beam direction is along the ultrasonic axis but the beam 
electronic scanning direction is parallel to the index axis. Consequently, the probe 
skew is equal to 90°.
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Figure 3-9  Plate inspection with 90° probe skew

In the example shown in Figure 3-10 on page 68, the angle beam probe is moving on 
the inspected part along the scan axis and the beam direction is parallel to the scan 
axis. Consequently, the probe skew is equal to 0°.

Figure 3-10  Rivet inspection with 0° probe skew
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In the example shown in Figure 3-11 on page 69, a mechanical scanner is holding two 
angle beam PA probes and two angle beam UT probes. The four angle beam probes 
are moving on the inspected part along the scan axis and the along the weld. The 
direction of the beam is parallel to the index axis. Consequently, the probe skews are 
equal to 90° or to 270°.

Figure 3-11  Weld inspection using a scanner with 90° and 270° probe skews

In the example shown in Figure 3-12 on page 70, the angle beam probes are moving 
on the inspected disc or wheel circumference along the scan axis. The beam direction 
is parallel to the scan axis. Consequently, the probe skews are equal to 0° or to 180°.
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Figure 3-12  Disc or wheel inspection with 0° and 180° probe skews

In the example shown in Figure 3-13 on page 71, two facing angle beam PA probes are 
moving on the inspected tube along the scan axis along the weld. The scan axis, 

represented by the symbol  in Figure 3-13 on page 71, is oriented in the third 
dimension perpendicular to the plan of the figure and extends in a direction away 
from the reader’s point of view. The beam directions are parallel to the index axis. 
Consequently, the probe skews are equal to 90° and 270°.
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Figure 3-13  Tube weld inspection with 90° and 270° probe skews

3.6 Layouts

In FocusPC, a layout is an organization of two or more views appearing in the 
window. Layouts offer extensive flexibility in how you present your inspection data.

FocusPC offers a set of ten layouts that are available on the Dashboard for quick 
selection (Figure 3-14 on page 71). You can also select one of the layouts on the Layout 
menu. A set of ten layouts is saved in an .rst file.

Figure 3-14  Set of ten layouts
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The predefined layouts button of the Dashboard allows you to quickly load a set of 
predefined layouts adapted to an application (Figure 3-15 on page 72).

Figure 3-15  Selecting predefined layouts

3.7 Views

Several types of views can be used to display the data for the current document. 
Figure 3-16 on page 72 contains an example of an A-scan data view.

Figure 3-16  Example of an active A-scan view

A view contains the following elements:

Title bar
The title bar of the active view is highlighted with a light-blue background as 
shown in Figure 3-17 on page 73.

Predefined layouts button

Title bar

Zoom bar

Ruler

Cursor

Note

Gate
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Figure 3-17  Example of the title bar of an active view

The title bar contains information describing the data in the view:

<Group Number><Group Name>[S: <Skew Angle>, A: <Beam Angles>]
where:

<Group Number>: Sequential number identifying the group (ex.: Gr1).

<Group Name>: Name of the group (ex.: Sectorial 1)

<Skew Angle>: Skew angle of the current group (ex.: 90°) taking into account 
the skew angle of the probe and of the beam.

<Beam Angles>: Angle or range of beam angles (ex.: 40° to 60°)

Rulers
The rulers are scales displayed at the left and at the bottom of a view. The color of 
the ruler identifies the axis. The units and number of precision digits can be 
adjusted using the View Properties > Units tab.

Zoom bar
Zoom bars appear at the left and bottom edges of a view. Each zoom bar contains 
a zoom box, which enables you to set the visible part of the view. The zoom box 
shows the relative position and the proportion of data currently visible in the data 
display area relative to the contents of the entire inspection domain. The color of 
the zoom bar identifies the axis on the different views. You can resize the zoom 
bar by dragging its ends to zoom in or out and scroll the zoom bar to see other 
parts of the data. You can use the mouse wheel with or without the CTRL key to 
scroll the zoom bars.

Grid
The grid consists of thin horizontal and vertical lines that are displayed in the 
curve area to facilitate measurements and correspondence with the rulers. 
Depending on the distance between lines, the grid might be coarse, medium, or 
fine. The grid can be activated and customized using the View Properties > 
Display tab.

Cursors
The cursors are thin horizontal and vertical lines that are used to measure the data 
displayed in views and to identify a region in the view. A label indicates the exact 
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measure of each cursor. Two cursor types are available for a view: reference and 
measurement cursors.

You can quickly display the reference cursor by double-clicking in a view. 
Similarly, double-right-click in a view to display the measurement cursor.

3.7.1 Data View Types

Data views are graphical representations of the ultrasonic data. There are three types 
of ultrasonic views:

1. Basic views:
— A-scan
— S-scan

2. Volumetric views:
— Side (B)
— Top (C)
— End (D)
— Polar

3. Scrolling views:
— Scrolling B-scan
— Scrolling strip chart (position)
— Scrolling strip chart (amplitude)

You can select the data view type for a view by selecting the view, and then clicking 

 or pressing SHIFT+ENTER to open the Contents dialog box (see example in 
Figure 3-18 on page 75). In the Contents dialog box, the available data view types 

depend on various parameters including the acquisition type (conventional [ ] or 

phased array [ ]) and the mode (Setup, Inspection, or Analysis).
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Figure 3-18  Example of data view types for phased array data

A view appears empty when its content (conventional [ ] or phased array [ ]) is 
not available in the current data file.

3.7.1.1 Basic Views

The following is a description of each type of basic view.

A-scan view

The A-scan view is the basis for all other views. It is a representation (view) of the 
received ultrasonic pulse amplitude versus time of flight (ultrasonic path), or a 
waveform. The A-scan view is displayed in real time (see example in Figure 3-19 on 
page 76). A peak in the signal is associated with the echo of a defect or a discontinuity 
in the specimen. Peaks at the start and the end of the ultrasonic axis are generally 
associated with the echo of the specimen’s entry surface (front wall) and the back wall.

TIP
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Figure 3-19  Example of an A-scan view

Sectorial views

Sectorial views are only available for phased array channels.

Sectorial views are representations of the juxtaposition of the A-scans associated with 
each focal law of a phased array scan. They present a 2-D view of the sector covered 
by the scan. Figure 3-20 on page 77 shows the three types of sectorial representation 
for a given data set.

NOTE
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Figure 3-20  Example of Uncorrected (top-left), USound corrected (top-right), and 
VC sectorial (bottom-left) scans

The three sectorial scan view types are:

Uncorrected sectorial scan
View where the A-scan of each focal law (see top-left view of the example in 
Figure 3-20 on page 77) is represented by a horizontal line on which the 
amplitude is color-coded. The displayed real-time data shows the focal laws 
stacked (vertically in the example) in the order that they were generated.

Sectorial scan (Usound corrected)
View similar to the uncorrected sectorial scan except that the A-scans are 
corrected for delay and true depth so that their positions are accurate relative to 
the ultrasonic axis (see top-right view of the example in Figure 3-20 on page 77).
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VC sectorial scan
Volume-corrected view similar to the uncorrected sectorial scan except that the 
A-scans are corrected for delay and refracted angle so that the positions are 
accurate relative to the ultrasonic and scan axes. A typical S-scan sweeps through 
a range of angles using the same focal distance and elements. The horizontal axis 
corresponds to the projected distance (test-piece width) from the exit point for a 
corrected image and the vertical axis corresponds to the depth (see bottom-left 
view of the example in Figure 3-20 on page 77).

When an azimuthal scan is defined by the calculator, the sectorial-scan view 
represents an angular sector where each line of this view corresponds to the A-scan of 
a different angle. Therefore, when a linear scan is defined, the sectorial-scan view 
represents the beam movement. Each line then corresponds to an A-scan of different 
aperture. Finally, when a depth scan is defined, the sectorial-scan view then 
represents the beam focusing at different depths. Each line then corresponds to a 
different A-scan.

3.7.1.2 Volumetric Views

Volumetric views are color-coded images built from successive A-scans projected on 
different planes defined by the ultrasonic, scan, and index axes. The most important 
views, similar to 2-D projections of a technical drawing, are presented in Figure 3-21 
on page 79.
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Figure 3-21  Example of ultrasonic views [Top (C), Side (B), and End (D)] with probe 
skew angle of 90°

In Figure 3-21 on page 79, if the probe skew angle is 0° (or 180°), the Side (B) view 
becomes the End (D) view, and vice versa. The Side (B) view is defined by the depth 
and probe-movement axes. The End (D) view is defined by the depth and the 
electronic-scan axis.

Side (B)

The Side (B) view (Figure 3-22 on page 80) is a two-dimensional graphical 
representation of the recorded data. One of the axes is the scan axis; the other is the 
uncorrected ultrasonic (USound) path. The position of the displayed data is related to 
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the encoder positions at the moment of acquisition. At a given position on the 
projected image, the color corresponds to the maximum amplitude at this position as 
detected in the considered index-axis range.

Figure 3-22  Example of Side (B) view

Top (C)

The Top (C) view (Figure 3-23 on page 81) is a two-dimensional graphical 
representation of the recorded data displayed as a top view of the test specimen. One 
of the axes is the scan axis; the other is the index axis. The position of the displayed 
data is related to the encoder positions at the moment of acquisition. At a given 
position on the projected image, the color corresponds to the maximum amplitude at 
this position as detected in the considered true-depth range.
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Figure 3-23  Example of Top (C) view

End (D)

The End (D) view (Figure 3-24 on page 82) is a two-dimensional graphical 
presentation of the recorded data. One of the axes is the defined index axis; the other 
is the uncorrected ultrasonic (USound) path. The position of the displayed data is 
related to the encoder positions at the moment of acquisition. At a given position on 
the projected image, the color corresponds to the maximum amplitude at this position 
as detected in the considered scan-axis range.
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Figure 3-24  Example of End (D) view

Polar view

The Polar view is available only when the geometry of the specimen is identified as 

cylindrical. This can be done by clicking  (part and material definition) and then, 
in the Part Definition dialog box, defining the part as Cylindrical.

The Polar view (Figure 3-25 on page 83) is a two-dimensional representation of the 
recorded data in a realistic cylindrical geometry. It is used in Analysis mode. The 
readings in the Cylindrical Correction category are calculated taking into account the 
previously defined specimen.

NOTE
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Depending on the orientation of the scan axis relative to the cylindrical geometry, and 
the skew angle of the considered probe, the Polar view is the cylindrical equivalent of 
either the VC-Side (B) view or the VC-End (D) view. Either distance units (mm or in.) 
or rotational units (°) can be used and displayed in the circumferential direction of the 
cylinder.

The Polar view is only supported for skew angles of 0°, 90°, 180°, and 270°; however, 
for data with other skew angle values, the Cylindrical Correction view information 
can be used to calculate the correct position and size of indications.

Figure 3-25  Example of a Polar view

3.7.1.3 Scrolling Views

Several types of scrolling views are available on FocusPC, as described below.

NOTE
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Scrolling B-scan

In the Scrolling B-scan view (Figure 3-26 on page 84), each A-scan is represented by a 
horizontal line on which the amplitude is color-coded. The lines are added 
consecutively in real time, from the bottom, so that the resulting image scrolls up. 
Therefore, the data view shows the real time vertically, versus the time of flight of the 
received ultrasonic pulse horizontally.

Figure 3-26  Example of Scrolling B-scan view
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Strip charts — amplitude and position scrolling views

The amplitude and/or position scrolling views are only available when the options for 
the recording of the selected amplitude and/or position data are enabled on the Gates 
tab of the UT Settings dialog box (refer to the FocusPC Advanced User’s Manual).

In an amplitude or position scrolling view, the data of the signal crossing the 
associated gate is represented by a color-coded Scrolling view, which is displayed 
inside a Strip Chart view. The Scrolling view can be configured using the 
Configuration tab of the View Properties dialog box (available only when a Strip 
Chart view is selected).

Figure 3-27  Example of amplitude scrolling view

3.7.2 View Shortcut Menu

When a data view type is assigned to a view, display options are available from a 
shortcut menu. The shortcut menu appears when you right-click the title bar of a view 
(see example shown in Figure 3-28 on page 86).

NOTE
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Figure 3-28  Example of the shortcut menu for a view

The view shortcut menu changes depending on the view type. The possible view 
shortcut menu commands are the following:

Data commands

Set Active Data Group Settings
Provides one or more choices (Active Group, Active Law, and Active Gate) to set 
the view to show data for the active item (group, beam, or gate), automatically 
following changes of the active selection.

Set Single Slice (Projection)
Toggles between the single- and projection-data displays in the view. The 
command is also available in the Data Source tab of the View Properties dialog 
box.

Set Data Group Representation
Provides one or more choices for sectorial scans (Sector (S) and TOF) [when you 
right-click on a view], and for C-scans (Stacked, Single Beam, Strip, and 
Scrolling Strip).
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Restore Initial Gates
Only available in Analysis mode, this selection is used to reposition all gates 
either for the current group or for all groups to the positions where they were 
when the data was originally acquired.

Set Dynamic Mode
Only available in Setup and Inspection mode, this selection is used to toggle 
between the dynamic state and the analysis state (off-line).

Show commands

Show Info Group
Toggles the appearance of the information groups below the title bar of the view.

Show Gate Selectors
Toggles the appearance of the gate selectors on the selected view.

Show Zoombar and Rulers
Toggles the appearance of the zoom bars and the rulers. The command is also 
available in the Display tab of the View Properties dialog box.

Show Echo Dynamics
Toggles the appearance of the echo dynamics signals next to the relevant axis. The 
echo dynamic curves show the maximum amplitude (or minimum position) 
between the measurement and reference cursors (see example shown in 
Figure 3-29 on page 88). The command is also available in the Echo Dynamics tab 
of the View Properties dialog box.

Show Skip Overlays
Toggles the appearance of the overlay lines representing the skips. The command 
is also available in the Overlay tab of the View Properties dialog box.

Show Rebounds
Toggles the appearance of the rebounds (see example shown in Figure 3-29 on 
page 88).
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Figure 3-29  Examples of shown echo dynamic curves and rebound

Show Gates
Toggles the appearance of the gates. This option is only available for A-scan and 
S-scan views. The command is also available in the Overlay tab of the View 
Properties dialog box.

Display mode commands

Set 1:1 Ratio Display Mode
Displays the view with the same scale on both axes. The command is also 
available in the Display tab of the View Properties dialog box.

Set Smoothing Display Mode
Enables the smoothing function. The command is also available in the Display tab 
of the View Properties dialog box.

Set Volume Corrected Display Mode
Toggles the A-scan correction for delay and refracted angle so that the positions 
are accurate, relative to the ultrasonic and scan axes.

Rotate View
Rotates the data so that the two axes interchange. The command is also available 
in the Display tab of the View Properties dialog box.

Echo dynamics Rebound
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Color palette commands

The following shortcut menu commands are also available on the Palette tab of the 
View Properties dialog box. These commands are only available on the menu when 
the view supports a color palette.

Select Color Palette
Used to select one of the available color palettes (Rainbow, Gray, Thickness, or 
Balanced).

Set Color Palette Compression Mode
Toggles the state of the color palette compression. When you reduce the range for 
the 256 colors of a palette without compression, you remove colors from the 
palette. With compression, all palette colors are compressed in the new range.

Edit Color Palette
Opens the Palette Editor dialog box, where you can edit existing color palettes or 
create new color palettes.

Display preferences commands

Save Display Preference
Saves the current view properties as the default properties.

Apply Display Preference
Applies the default view properties to the currently selected view.

On the keyboard, press F4 and SHIFT+F4 to respectively activate the Save Display 
Preference and the Apply Display Preference commands.

Ultrasonic axis commands

Reverse USound Axis
Reverses the direction of the ultrasonic axis. The command is only available for 
the A-scan view. The command is also available on the Display tab of the View 
Properties dialog box.

TIP
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Change USound True Depth / Half Path
Toggles the ultrasonic axis unit between true depth and half path. The command 
is only available for the A-scan view when the ultrasonic axis is set to either true 
depth or half path.

Change USound TOFD / Time
Toggles the ultrasonic axis ruler between TOFD and time. The command is only 
available for the A-scan view when the ultrasonic axis is set to either time or 
TOFD.

You can set the type and the units of USound axis in the Units tab of the View 
Properties dialog box.

Calibrate UT Axis
Only available in Analysis mode, this command opens the dialog box for the 
calibration of the True Depth, the Half Path, or the TOFD on the ultrasonic axis. 
The command is also available on the Units tab of the View Properties dialog box 
and in Setup mode, on the General tab of the UT Settings dialog box.

3.8 Readings and Information Groups

FocusPC computes reading values for various parameters to help you analyze your 
ultrasonic data. Readings are calculated using cursor, zone, or acquisition parameters.

You can select to display one or more groups of readings at the top of a view 
(Figure 3-30 on page 91).

TIP
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Figure 3-30  Example of reading groups appearing at the top of a view

See “Working with the Readings” on page 135 for more information on how to 
customize the reading groups.

3.9 Gates

A gate is a signal processing tool that isolates a time domain region of the received 
ultrasonic signal in order to process it further. In an A-scan view, a gate appears as a 
horizontal line with short vertical lines at both ends. The vertical position of the gate 
line indicates the signal detection threshold (Figure 3-31 on page 92). When the 
rectification of the receiver is set to RF, the threshold of a gate can be positive or 
negative.

Reading groups
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Figure 3-31  Example of gate A in an A-scan

In an S-scan view, the gate start and end positions appear as horizontal dashed lines 
(Figure 3-32 on page 92). When the time base mode is set to true depth, the area in 
between is the gated zone for all beams. When the time base mode is set to half path, 
the area between the dashed lines is the gated zone for the current beam only. The 
dashed lines of the gate automatically move to the appropriate location when you 
change the current beam.

Figure 3-32  Example of gate A in an S-scan

Gate threshold

Gate length

Gate start position

Gate start

Gate length
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FocusPC supports up to five gates (gate I, gate A, gate B, gate C, and gate D), allowing 
you to perform complex signal processing. The function of gate I, the interface gate, is 
to identify the interface of the inspected part. Gate A, B, C, and D are general purpose 
gates (see “Gate Usage Example” on page 143). Each gate has its own color to easy 
identification (Figure 3-33 on page 93).

Figure 3-33  Gate colors

3.10 Expert Mode

FocusPC includes an Expert mode in which a larger number of readings are available. 
The categories of readings available in the Information Groups dialog box when 
Expert mode is active are shown in Figure 3-34 on page 93.

Figure 3-34  Categories of readings in the Expert mode
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To activate/deactivate Expert mode

1. On the main menu bar, select File > Preferences.
2. In the Preferences dialog box, select the General Settings tab.
3. Under Interface, select or clear the Expert mode check box, to respectively 

activate or deactivate the Expert mode.

3.11 File Formats

FocusPC can produce, open, and import various data types stored in various file 
formats listed in Table 3 on page 94.

The hierarchical content of the file formats generated by FocusPC is illustrated in 
Figure 3-35 on page 95.

Table 3  File formats supported by FocusPC 

File type Extension File content

Hardware setup .fps Setup of the acquisition instrument

Data .fpd Data file that contains display setup information 
and acquisition setup information

Display setup .rst Display setup: layouts and system preferences

Report .r01 Report information including indication zone data

Calculator setup .xcal Calculator extended setup file

.cal Calculator setup file

.law Calculated beam parameters

.pac Calculated beam parameters readable by FocusPC

Attributes .A01 Attributes: data modified in analysis and associated 
with the .fpd file
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Figure 3-35  FocusPC file organization

The preferences data saved in the .rst file include view linking options, axis colors, 
view colors, tool colors, and the measurement system. By default, the contents of the 
.rst file is included in the .fps file.

You can customize the default folders for the various data file types (refer to the 
FocusPC Advanced User’s Manual for details).

.r01 file

Report information
Indication zone data

.a01 file

Volumetric merge parameters
Indication table
TOFD processing
Software C-scan

.rst file

Layouts
Indication table customization

.xcal file

Calculator parameters
Simulation results

.fps file

UT Settings
Scan settings
Preferences (see following note)

.fpd file

Raw UT data (amplitude, position)

NOTE

NOTE
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4. Setup Creation

A FocusPC configuration can be saved in the .fps (acquisition, also referred to as the 
setup) file, which can be recalled at any time. This section describes the basic steps for 
creating a setup file using FocusPC, starting from the default configuration.

4.1 Working with Setup Files

The following section describes how to create setup files.

4.1.1 Loading an .fps Setup File

The FocusPC configuration can be stored in the .fps file. An .fpd (data) file can also be 
recalled to load the .fps configuration that was used at the time when the data was 
recorded. You can reload the parameters into the ultrasonic acquisition instrument to 
perform acquisition with the same parameters or to display the parameters that were 
used for acquisition.

To load an .fps setup file

1. On the main menu bar, click File > Open to open a setup file.
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Figure 4-1  Open dialog box

2. In the Open dialog box that appears (Figure 4-1 on page 98), proceed as follows:
a) If a data file was selected, clear the Data (*.fpd) check box.
b) In the File Content section, select the file to be loaded.
c) Click Open.

4.1.2 Saving an .fps Setup File

To save an .fps setup file

1. On the main menu bar, click File > Save As to save a setup file.
2. In the Save As dialog box that appears (Figure 4-2 on page 99), proceed as 

follows:
a) For the .fps file to be saved, enter the File Name.
b) In the File Content section, select the elements to be saved.
c) Click Save to save the .fps file.

OR
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Click Set as default to make this setup file the new default configuration.

Figure 4-2  Save As dialog box

4.1.3 Default Setup Files

FocusPC comes with a number of default setup files that are designed to provide a 
good starting point.

The default setup files are available in the default setup file folder ([Installation 
Folder]\EvidentNDT\FocusPCnnn\Setup Files).

4.2 Working with Groups

In FocusPC, a group is a defined configuration of parameters to generate one or more 
ultrasonic beams using a conventional or phased array probe. A group can pulse and 
receive on the same probe, or you can use two different probes, one to pulse, and the 
other to receive, and a probe can be used by more than one group. The following 
sections describe how to create and configure phased array and conventional UT 
groups (see “Groups” on page 61 for more information on groups).
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4.2.1 Adding and Configuring a Phased Array Group

The following procedure describes how to create a phased array group in FocusPC. 
Although some of the steps may not be mandatory for all inspection types, it provides 
an overview of the power and flexibility of FocusPC.

To add and configure a phased array pulse-echo group

1. On the Dashboard, click  to add a group (Figure 4-3 on page 100).

Figure 4-3  Adding or selecting a group

2. In the Group Creation Wizard dialog box that appears (Figure 4-4 on page 101), 
proceed as follows:
a) Select Phased array for the type of group to create.
b) Enter a name for the new group in the Specify name box (for example: Angle 

Beam).
c) Click Finish.

Select the group

Start the Calculator

Add a group
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Figure 4-4  Group Creation Wizard dialog box

3. On the Dashboard (Figure 4-3 on page 100), proceed as follows:
a) Select the newly created group.

b) Click  to open the Calculator.
The Calculator is where you specify the probe and wedge used for the 
inspection, the geometry and material of the inspected part, and the beam 
configuration. See “Calculator” on page 63 for details.

4. In the Calculator, perform the following tasks:
a) For an angle beam phased array inspection, click the 1-D Linear Array tab 

(Figure 4-5 on page 102).
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Figure 4-5  Calculator dialog box

b) Under Probe, select the type of probe (Angle Beam) and the probe model 
(Figure 4-6 on page 103).
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Figure 4-6  Selecting the probe

c) Under Part, select the inspected part geometry type and enter its thickness 
(Figure 4-7 on page 103).

Figure 4-7  Specifying the inspected part geometry

d) Under Material, select the inspected part material and the Longitudinal or 
Transverse ultrasonic wave type (Figure 4-8 on page 104).

Type

Model
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Figure 4-8  Specifying the inspected part material

e) Under Wedge, select the type of wedge and the wedge model (Figure 4-9 on 
page 104).

Figure 4-9  Specifying the wedge

f) In the Scan Type list, for an angle beam inspection, select Sectorial, Depth, 
Static, or Linear. For more information on the differences between the Scan 
Types, refer to the Advanced NDT Series books available for free on the Evident 
website.

g) Under Beam Angles Selection, select Refracted angle, and then specify the 
Start value and the Stop and Resolution values if they are available (depends 
on the selected Scan Type).

Type

Model
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h) Under Focal Points Selection, set the Focusing type to True Depth, Half 
Path, Projection, or Focal Plane, and if desired, select if you want to have 
dynamic depth focusing (DDF) activated. Then, define the Focal plane 
position, Emission focus position, and Reception focus position if available.

i) Under Elements Selection, select Primary axis aperture, and then enter the 
number of elements to use for each focal law. Then, define the Start, Stop, and 
Resolution values if available.

j) Under Connection, set the Pulser and the Receiver values. This will define 
the element to use as the first element for the transmitter and receiver focal 
laws.

k) At the bottom of the Calculator, click Draw.
FocusPC prepares the beam display information.

l) Wait for the progress bar to complete.
m) At the top of the Calculator, click the Beam display info tab.
n) Use the four views and the parameters below the views to validate the 

calculated beams (Figure 4-10 on page 106).
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Figure 4-10  Example of the Beam display info tab in the Calculator

o) Return to the 1-D Linear array tab, and then, if necessary, make further 
adjustment to the parameters.

p) At the bottom of the Calculator, click Replace to calculate the configured focal 
laws and send the information back to FocusPC.

To add and configure a phased array pitch-catch or through-transmission group

1. Follow steps 1 to 4.e of the procedure called “To add and configure a phased array 
pulse-echo group” on page 100.
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2. Click  to open the Calculator:
a) Under Scan Type, select Static.
b) Under Beam Angles Selection, select Refracted angle, and then specify the 

Start value for the Pulser.
c) Under Elements Selection, define the Start and Primary axis aperture values.
d) At the bottom of the Calculator, click Replace to calculate the configured focal 

laws and send the information back to FocusPC.

3. Click  to open the Calculator:
a) Under Beam Angles Selection, select Refracted angle, and then specify the 

Start value for the Receiver.
b) Under Elements Selection, define the Start and Primary axis aperture values.
c) Under Probe, define the Probe skew angle for the receiver, if necessary.
d) At the bottom of the Calculator, click Replace Rec to calculate the configured 

reception focal laws and send the information back to FocusPC.

4. Click  to open the Calculator:
a) In the Phased Array Parameters Source dialog box (Figure 4-11 on page 107), 

select the sector to be edited, and then select Emission and click OK.
The Calculator will open with the corresponding Pulser configuration.

b) In the Calculator, click Add.
This will add a new beam with a similar configuration to the one defined in 
step 2.

Figure 4-11  Phased Array Parameters Source dialog box
Setup Creation 107



DMTA-20092-01EN, Rev. G, September 2022
5. Click  to open the Calculator:
a) In the Phased Array Parameters Source dialog box (Figure 4-11 on page 107), 

select the sector to be edited and then select Emission, and then click OK.
b) Edit the different available parameters, if necessary.
c) At the bottom of the Calculator, click Replace to calculate the configured focal 

laws and send the information back to FocusPC.

6. Click  to open the Calculator:
a) In the Phased Array Parameters Source dialog box (Figure 4-11 on page 107), 

select the sector to be edited, and then select Reception and click OK.
b) Edit the different available parameters, if necessary.
c) At the bottom of the Calculator, click Replace Rec to calculate the configured 

reception focal laws and send the information back to FocusPC.
7. Repeat steps 4 to 6 until all your beams are properly configured.

4.2.2 Adding and Configuring a CAF Group

The following procedure describes how to create a CAF group in FocusPC software. 
Although, some of the steps may not be mandatory for all inspection types, they 
provide an overview of the power and flexibility of FocusPC.

A coherent adaptive focusing (CAF) group enables the phased array beams to adapt 
to targets with varying geometries in real time. For each acquisition, an algorithm 
identifies the shape of the target and recalculates the focal law delays to generate an 
ultrasonic wave front that is parallel to the part’s surface.

Setting the parameters of a CAF group (see “Working with CAF Groups” on 
page 149), is in most respects the same as a phased array group, though with some 
exceptions; for example, you cannot set up a pitch-catch configuration with CAF. 
Procedures for CAF groups (such as calibration) are performed in the same way as for 
phased array groups. 

To add and configure a CAF group

1. Follow the same process as for the phased array group (see “Adding and 
Configuring a Phased Array Group” on page 100).

2. In the Group Creation Wizard dialog box, select Coherent Adaptive Focusing 
(CAF) (Figure 4-12 on page 109) instead of Phased array.
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Figure 4-12  Group Creation Wizard dialog box

All subsequent creation steps are the same as a phased array group.

4.2.3 Adding and Configuring a Conventional UT Group

The following procedure describes how to create a conventional UT group in 
FocusPC. The configuration of a conventional UT group is not performed in the 
Calculator as is done for the phased array groups. Therefore, the acoustic 
configuration and part definition will need to be performed separately.

To add and configure a conventional UT group

1. On the Dashboard, click  to add a group.
2. In the Group Creation Wizard dialog box that appears (Figure 4-13 on page 110), 

proceed as follows:
a) Select Conventional UT for the type of group to create.
b) Enter a name for the new group in the Specify name box (for example, 

Conventional Beam).
c) If you want the Conventional UT group to be configured on the phased array 

connector rather than the HD connectors, clear the Use HD Connectors check 
box.

d) Click Finish.
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Figure 4-13  Group Creation Wizard dialog box (conventional UT)

3. On the component toolbar, click  (part and material).
4. In the Part Definition dialog box (Figure 4-14 on page 111), proceed as follows:

a) Under Material Velocity, set the ultrasonic velocities for the Longitudinal 
waves and Transversal waves in the part.

b) Under Dimensions, set the values describing your part.
c) For cylindrical parts, under Probe Positioning, select the appropriate 

Inspection from and Scan orientation values.
d) Click OK.
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Figure 4-14  Part Definition dialog box

5. On the Dashboard, select the newly created group (Figure 4-15 on page 111).

Figure 4-15  Selecting the UT group in the Dashboard

Select the group
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6. On the component toolbar, click the UT Settings button ( ).
7. In the UT Settings dialog box, proceed as follows:

a) On the Pulser/Receiver tab, set the connectors for Pulser and Receiver along 
with the Pulse width value for your UT probe.
Divide 500 by the probe frequency expressed in MHz to get the pulse width 
value expressed in ns (ex.: 500/10 MHz = 50 ns).

b) On the Position tab, under Probe, define the Scan offset and Index offset 
values.

c) On the Position tab, under Beam, enter the appropriate Refracted angle and 
Skew angle values.

4.2.4 Adding and Configuring a TOFD Group

The following procedure describes how to create a TOFD group in FocusPC. Just as 
for a Conventional UT group, the TOFD configuration is not performed in the 
Calculator. Therefore, the acoustic configuration is performed separately.

To add and configure a TOFD group

1. On the Dashboard, click  to add a group.
2. In the Group Creation Wizard dialog box that appears (Figure 4-16 on page 113), 

proceed as follows:
a) Select TOFD for the group type.
b) Enter a name for the new group in the Specify name box (for example, TOFD 

group).
c) If you want the Conventional UT group to be configured on the phased array 

connector rather than the HD connectors, clear the Use HD Connectors check 
box.

d) Click Finish.
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Figure 4-16  Group Creation Wizard dialog box (TOFD)

3. In the UT Settings > Pulser/Receiver dialog box:
a) Under Pulser, set Connector to the value corresponding to the pulser 

connector number.
b) Under Receiver, set Connector to the value corresponding to the receiver 

connector number.
c) Set the Voltage to the highest value available.
d) Set the Pulse width value for your UT probe.

Divide the number 500 by the probe frequency (expressed in MHz) to obtain 
the pulse width value expressed in ns (ex., 500/10 MHz = 50 ns).

4.2.5 Switching between Groups

When you have more than one group in a configuration, you often need to switch the 
focus from one group to the other.

To switch between groups

1. Right-click the view header (at the top of the view) and select Active Group 
(Figure 4-17 on page 114).

2. On the Dashboard, change the active group.
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Figure 4-17  Selecting Active Group

4.2.6 Renaming Groups

To rename a group

1. Click  to open the UT Settings dialog box.
2. In the UT Settings dialog box, select the Group you want to rename.
3. Click in the Group box, and then type the new group name.
4. Press Enter.

4.2.7 Deleting Groups

To delete a group

1. On the Dashboard, select the Group you want to delete.

2. Click the Delete button ( ).
A message appears (Figure 4-18 on page 115), asking you to confirm deletion of 
the group.
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Figure 4-18  Message for deleting a group

3. Click OK to confirm the operation.

4.3 Calibrating a Phased Array Group

The phased array technique requires the calibration and verification of all the UT 
beams. The purpose of the calibration is to obtain a setup file that yields correct 
results regarding the position and amplitude of a known reflector in a calibration 
block.

The following sections present the calibration procedures to calibrate the beam delays 
and sensitivity for phased array groups. For the phased array TCG calibration 
procedure, see “Constructing a TCG Curve for a Phased Array Group” on page 129.

4.3.1 Calibrating the Beam Delays

The purpose of the phased array beam delay calibration is to adjust the delay of each 
beam so that the indication of a known reflector appears at the correct depth for all 
beams. This procedure must be performed for each group.

To calibrate the beam delays

1. On the component toolbar, click  (Phased Array Calibration).
2. In FocusPC, in a Side (B), End (D), or Sector (S) view, position the Reference (red) 

and Measurement (blue) cursors respectively above and below the reference 
reflector of the calibration block (Figure 4-19 on page 116).
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Figure 4-19  Example of cursors around an indication in a Sector (S) view

3. In the Phased Array Calibration dialog box, proceed as follows:
a) Select the Beam Delays tab (Figure 4-20 on page 116).

The graph presents the ultrasonic path between the Reference and 
Measurement cursors on the vertical axis and the beams on the horizontal 
axis.

Figure 4-20  Curves for the beam delay calibration

Distance envelope (blue line) representing the depth of the maximum amplitude for 
each beam at a given moment

Dash lines representing the tolerance limits

Red line representing the depth of the highest maximum amplitude obtained for a 
given beam during the scan

Straight black line showing the real depth of the known reflector
Chapter 4116



DMTA-20092-01EN, Rev. G, September 2022
b) Under Calibration, in the Reflector position parameter, enter the true depth 
of the known reflector used for this calibration.

c) If the reflector echo is too weak or too strong, adjust the Group gain 
parameter.

d) In the Tolerance parameter, enter the acceptable calibration tolerance.
e) Select the Linear interpolation check box to activate the averaging of the 

beam delays. The resulting line applies a global correction.
4. During the scan, the distance envelope (blue line) obtained for each beam is 

drawn, and a curve representing the position of the maximum amplitude is 
constructed (red line).

5. Place the probe on the calibration block and perform a first scan above the 
reference reflector.

After a scan, the maximum amplitude curve (red line) should already be close to the 
tolerance limits. When the maximum amplitude curve shape is significantly different, 
revise the configuration of all parameters in the Calculator.

6. In the Phased Array Calibration dialog box, click Clear Trace to clear the data 
from the previous scan.

7. Perform a new scan above the reference reflector on the calibration block.
In the graph, the red line might not always appear within the tolerance lines.

8. Click Calibrate.
The graph content is cleared and FocusPC calculates the wedge delay for each 
beam so that the reflector indication appears at the requested depth.

9. Perform a new scan above the reference reflector on the calibration block to 
validate the calibration by confirming that the red line appears within the 
tolerance lines.

IMPORTANT
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Figure 4-21  Red line appearing between tolerance lines after calibration

10. If the calibration is not successful, repeat steps 6 to 9.
11. If you need to reset the calibration, proceed as follows:

a) On the Dashboard, click the Calculator button ( ).
b) In the Calculator, click Replace.

4.3.2 Calibrating the Sensitivity

The purpose of the phased array sensitivity calibration is to adjust the gain of each 
beam so that the amplitude of a known reflector appears at the same level for all 
beams.

To calibrate the sensitivity

1. On the component toolbar, click  (Phased Array Calibration).
2. In the Phased Array Calibration dialog box, click the Sensitivity tab.
3. Couple the probe to the calibration block and perform a first scan on the 

calibration block above a reference reflector.
During the scan, FocusPC draws the distance envelope (blue line) obtained for 
each beam and constructs a curve (red line) representing the position of the 
maximum amplitude (Figure 4-22 on page 119).
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Figure 4-22  Sensitivity example after a first scan

4. In FocusPC, in a Side (B), End (D), or Sector (S) view, position the reference (red) 
and measurement (blue) cursors respectively above and below the reference 
reflector of the calibration block (Figure 4-19 on page 116).

5. In the Phased Array Calibration dialog box:
a) Set the Reflector amplitude parameter to the amplitude (%) at which you 

wish to see the reference reflector maximum amplitude appear.
b) In the Tolerance parameter, enter the acceptable amplitude tolerance.
c) If the reflector echo is too weak or too strong, adjust the Group gain 

parameter.
d) Click Clear Trace to clear the data from the previous scan.

6. Perform a new scan above the reference reflector on the calibration block.
7. Click Calibrate.

FocusPC clears the graph content and calculates the gain for each beam so that the 
reflector echo amplitude appears at the requested level for all beams.

8. Perform a new scan above the reference reflector on the calibration block to 
validate the calibration by confirming that the red line appears within the 
tolerance lines (Figure 4-23 on page 120).
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Figure 4-23  Curves for the sensitivity calibration

9. When the calibration is not successful, repeat steps 6 to 8.
10. If you want to review or reset the beam gains:

a) On the component toolbar, click  (UT Settings).
b) In the Beam list above the tabs, select the desired beam.
c) In the General tab, under Gain, review or edit the Beam gain.
d) If required, reset the sensitivity calibration by clicking Reset Beam.

4.4 Calibrating a Conventional UT Group

You can calibrate the ultrasonic velocity and the wedge delay of a conventional UT 
group using the parameters available on the General tab of the UT Settings dialog 
box (Figure 4-24 on page 120).

Figure 4-24  General tab of the UT Settings dialog box for a UT group
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You need a calibration block with one known reflector to perform the delay 
calibration and a calibration block with two known reflectors to perform the velocity 
calibration.

To calibrate a conventional UT group

1. On the component toolbar, click  (UT Settings).
2. On the Dashboard, select the conventional UT group that you want to calibrate.

If necessary, you can create a new group by clicking the Add a new group button 

( ) on the Dashboard and selecting the Conventional UT option.

3. In the UT Settings dialog box, select the probe category and model (Figure 4-25 
on page 121).

Figure 4-25  Selecting the probe in the UT Settings dialog box

4. Place the probe on the calibration block and position the probe over the two 
reflectors with known positions.

5. On an A-scan view, proceed as follows:
a) Select and configure the view to see the echoes of the two reflectors.
b) Position the Reference cursor (red line) on the echo of the first reflector.
c) Position the Measurement cursor on the echo of the second reflector.

6. In the UT Settings dialog box, on the General tab:
a) Under Time Base, set Mode to Half path.
b) Under Auto Values, click Calibrate.

7. In the Time / Half Path dialog box that appears (Figure 4-26 on page 122), 
proceed as follows:
a) Under What Do You Want to Compute, select Compute Velocity and delay.

Active UT groupProbe category and model
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b) Set Ref. cursor position to the known position of the first reflector.
c) Set Meas. cursor position to the known position of the second reflector.
d) Click OK.

FocusPC calculates the ultrasonic velocity and wedge delay and sets the 
corresponding values in the UT Settings dialog box, on the Position tab.

Figure 4-26  Calibrating with the Time / Half Path dialog box

4.5 Calibrating a TOFD Group in Setup Mode

Although TOFD groups are generally calibrated in Analysis mode, the following 
procedure explains how to calibrate in Setup mode. For more information on how to 
calibrate a TOFD group in Analysis mode, refer to the FocusPC Advanced User’s 
Manual.

To calibrate a TOFD group in Setup mode

1. On the component toolbar, click  (add view content) and display the TOFD 
group A-scan and Side (B) views.

2. In the UT Settings > General dialog box, under Time Base, set Mode to TOFD.
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3. On the component toolbar, click  to open the TOFD Manager dialog box.
4. In the TOFD Manager dialog box, click Calibration.
5. In the TOFD dialog box, proceed as follows:

a) Under What Do You Want to Compute?, define which parameters you want 
to compute.

b) Under Scan axis, define the scan axis as either parallel to beam, or 
perpendicular to beam.

c) Under TOFD primary value and TOFD secondary value, define the 
requested parameters.

d) Click OK.

If you select the Compute velocity and wedge delay option under What Do You 
Want to Compute? in the TOFD dialog box, the measurement cursor has to be 
positioned on a second reference signal (for example, lateral wave).

The ultrasonic axis is now calibrated in Setup mode.

4.6 Working with Overlay Drawings

An overlay is a graphical representation of weld geometry or of a part that is 
superimposed over an ultrasonic data view. The overlay helps to visualize where 
defects are physically located relative to the weld or to the part geometry. FocusPC 
provides predefined customizable overlays.

For weld inspection applications, you can add a weld drawing as an overlay in the 
view.

To create a weld overlay

1. On the component toolbar, click  (Add Weld), and proceed as follows:
a) In the Predefined Weld dialog box, click the appropriate weld type to open 

the Weld Parameters dialog box (Figure 4-27 on page 124).

NOTE
Setup Creation 123



DMTA-20092-01EN, Rev. G, September 2022
Figure 4-27  Predefined Weld and Weld Parameters (for Type 1) dialog boxes

b) In the Weld Parameters dialog box, type appropriate values to define your 
weld, and then click OK.

c) Back in the Predefined Weld dialog box, select the Automatic flip check box, 
and then click OK.
The weld overlay appears in the view (Figure 4-28 on page 125).
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Figure 4-28  Example of a weld overlay with three flips

4.7 Working with the TCG Curve

The time-corrected gain (TCG) function operates by modifying the receiver gain 
during data acquisition to compensate for the attenuation of the ultrasonic wave in 
the material. The TCG curve defines gain values that are added to the group gain.

FocusPC offers two methods to construct a TCG curve. For a UT conventional group 
(mono-element probe) or for a linear 0-degree phased array group, you can use the 
controls on the TCG tab of the UT Settings dialog box (see “Constructing a TCG 
Curve for a Conventional UT Group” on page 125). For a phased array group, use the 
Phased Array Calibration component (see “Constructing a TCG Curve for a Phased 
Array Group” on page 129).

In order to build a TCG curve, a calibration block is required with same-sized 
reflectors at different depths. You can then display the TCG curve as a red line at the 
top of the corresponding A-scan view (see “Displaying or Hiding the TCG Curve” on 
page 128).

4.7.1 Constructing a TCG Curve for a Conventional UT Group

Use the controls on the TCG tab of the UT Settings dialog box to construct a TCG 
curve for a UT conventional group or for a 0-degree linear phased array group to 
which the same TCG curve is applied to all laws.

Original overlay

First flip

Second flip

Third flip
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To construct a TCG curve for a conventional UT group

1. Choose a layout that includes an A-scan view.
2. Enable the TCG function:

a) On the component toolbar, click  (UT Settings).
b) In the UT Settings dialog box, click the TCG tab, and then select the Enable 

check box (Figure 4-29 on page 126).

Figure 4-29  TCG tab of the UT Settings dialog box

3. Set Current TCG to either Full Range or High Resolution.

Only the High Resolution option is available for UT groups on the HD connectors.

4. Place the probe on a calibration block that has same-sized reflectors at different 
known depths.

5. Position the probe to get well-defined echoes on the A-scan (Figure 4-30 on 
page 127).

NOTE
Chapter 4126



DMTA-20092-01EN, Rev. G, September 2022
Figure 4-30  A-scan before adding the first TCG point

6. In the UT Settings dialog box, set the Reference level parameter to the amplitude 
level for the echo, expressed in percent of the full-screen height. The 80 % default 
setting is suitable as a basic setting in most cases.

7. On the A-scan view, position the Reference and the Measurement cursors to the 
left and the right of the echo by double-clicking and double-right-clicking 
respectively.

8. Maximize the signal amplitude by moving the probe over the indication. Use the 
envelope tool to help you find the maximum signal.

9. In the UT Settings dialog box, click Add Point to add the chosen point to the TCG 
curve. When needed, click New Line to add an empty line.
FocusPC adjusts the gain to bring the peak of the selected echo to 80 % of the full-
screen height.
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Figure 4-31  A-scan after adding the first TCG point

10. Repeat steps 7 to 9 for each point you want to add to the TCG curve. A minimum 
of two points is required to define a functional TCG curve.

A Point gain with a negative value is not applied. Ensure to construct your TCG curve 
without negative point gains. Point 0 corresponding with the interface is not always 
the one with the highest amplitude.

4.7.2 Displaying or Hiding the TCG Curve

The TCG curve can be displayed or hidden using the following steps:

To display or hide the TCG curve

1. Select the A-scan view in which you want to display or hide the TCG curve.

2. On the component toolbar, click  (UT Settings).
3. In the UT Settings dialog box, select the TCG tab.
4. Select or clear the Display check box to respectively display or hide the TCG 

curve.

IMPORTANT
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The TCG curve appears as a red line at the top of the corresponding A-scan view.

Figure 4-32  Example of an A-scan view showing the TCG curve

4.7.3 Constructing a TCG Curve for a Phased Array Group

Use the controls in the TCG tab of the Phased Array Calibration dialog box to 
construct a TCG curve for a phased array group. For angle beam inspections such as 
in weld applications, you need to use the following procedure to calculate the TCG 
gain independently for each beam.

To construct the phased array TCG curve

1. Enable the TCG function by proceeding as follows:

a) On the component toolbar, click  (UT Settings).
b) In the UT Settings dialog box, click the TCG tab, and then select the Enable 

check box.

2. On the component toolbar, click  (Phased Array Calibration).
3. In the Phased Array Calibration dialog box, click the TCG tab.
4. In FocusPC, in a Side (B), End (D), or Sector (S) view (depends on probe skew), 

position the Reference (red) and Measurement (blue) cursors respectively above 
and below the reflector indication (Figure 4-19 on page 116).

5. Place the probe on the calibration block and perform a first scan on the calibration 
block above one reference reflector.

TCG curve TCG curve area
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During the scan, FocusPC draws the amplitude envelope (blue line) obtained for 
each beam and constructs a curve (red line) representing the maximum amplitude 
of the envelope (Figure 4-33 on page 130).

Figure 4-33  TCG curve construction example after a first scan

6. In the Phased Array Calibration dialog box, proceed as follows:
a) Set the Reflector amplitude parameter to the amplitude (%) at which you 

wish to see the reference reflector maximum amplitude appear.
b) In the Tolerance parameter, enter the acceptable amplitude tolerance.
c) Click Clear Trace to clear the data from the previous scan.

7. Perform a new scan on the calibration block.
8. To use this reflector to create a TCG curve point, click Add TCG Point.

FocusPC adjusts the gain for each beam to obtain the required reference 
amplitude for the depth corresponding to the inspected reflector.

9. Repeat steps 4 to 8 for each reference reflector used to construct the complete TCG 
curve.

You can review the TCG gain for each beam on TCG tab in the UT Settings dialog 
box.

TIP
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4.7.4 Importing a TCG Curve

The TCG curve points can be easily imported and exported directly from the FocusPC 
interface using simple .csv (comma-separated values) files using the following 
procedure.

To import a TCG curve

1. Create the .csv file containing the different TCG points for a particular group 
(Figure 4-34 on page 131):
a) Generate a line for every beam using the following structure where the 

Positions are defined in mm and the Gains are in decibels. Every number is 
entered with a three digits decimal precision.
Position 1, Gain 1; Position 2, Gain 2;....

b) Add comments at the end of every line as long as they are preceded by a “#” 
symbol.

c) Save or rename the file as a .csv file to be interpreted correctly.

Figure 4-34  TCG points import text

2. On the Dashboard, select the group to which you want to apply the TCG points.
3. On the TCG tab of the UT Settings dialog box:

a) Click Import.
b) Select the .csv file containing the TCG points.
c) Click Open.

The TCG point positions may differ from the ones defined in the .csv file if the 
positions defined in the .csv file do not match the available TCG point-position slots.

NOTE
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4.8 Working with Layouts

In FocusPC, a layout is an organization of two or more views appearing in the 
window. FocusPC offers a set of ten layouts available on the Dashboard for quick 
selection (Figure 4-35 on page 132).

Figure 4-35  Set of ten layouts

4.8.1 Applying a Template Layout File

FocusPC comes with a certain number of template layout files each containing up to 
ten layouts that can be selected to modify the current display. Additional layout files 
can also be created and defined as template layout files (see “Saving Layout Files and 
Defining New Template Layouts” on page 134 for more information).

To apply a template layout

1. On the Dashboard, click  to select a Template layout file.
2. From the list of available layouts, choose the most appropriate (Figure 4-36 on 

page 133).
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Figure 4-36  List of available layouts

4.8.2 Displaying or Changing the View in a Pane

After a layout has been selected, the views can be modified in order to customize the 
display.

To change the view in a pane

1. Activate the pane you want by clicking anywhere in it.

2. Click  on the component toolbar (or press SHIFT+ENTER) to open the 
Contents dialog box (Figure 4-37 on page 133).

Figure 4-37  Example of the Contents dialog box

3. Double-click the view type to display it in the active pane.
4. If required, activate another pane by clicking it, and then select the data and the 

view to be displayed in this pane.
Setup Creation 133



DMTA-20092-01EN, Rev. G, September 2022
The right section is updated to list the view types that are possible with the 
selected data type.

4.8.3 Saving Layout Files and Defining New Template Layouts

The list of template layouts described in “Applying a Template Layout File” on 
page 132 matches the content of the layout folder. The default layout folder is 
[Installation Folder]\FocusPCnnn\Layouts Files. You can customize the list of 
predefined layouts by adding, removing, or modifying the layout files and their 
subfolders.

Do not modify or delete the following layout files:

[Installation Folder]\FocusPCnnn\Layout Files\Viewer.rst

[Installation Folder]\FocusPCnnn\Layout Files\Composite\Composite.rst

[Installation Folder]\FocusPCnnn\Layout Files\Weld\Weld.rst

Changing or deleting the Viewer.rst file prevents the FocusPC Viewer edition from 
starting up. If this occurs, reinstall FocusPC to fix the problem.

To save a set of ten customized layouts

1. On the main menu bar, click File > Save As.
2. In the Save As dialog box that appears (Figure 4-38 on page 135), proceed as 

follows:
a) Select Displays Setup (*.rst) in the Save as type box.
b) Enter the File Name for the .rst file.
c) Click Save.

IMPORTANT
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Figure 4-38  Save As dialog box

4.9 Working with the Readings

FocusPC computes reading values for various parameters for analyzing ultrasonic 
data. Readings are calculated using cursor, zone, or acquisition parameters and can be 
displayed at the top of a view (Figure 4-41 on page 138).

4.9.1 Reading Management

You can define four groups of readings using the readings Information Groups 
dialog box (Figure 4-39 on page 136). You can access the Information Groups dialog 
box by double-clicking in the reading zone at the top of a view.
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The most frequently used readings are organized by categories under Favorite 
Readings in the Information Groups dialog box. Each category has a limited number 
of readings with short names. The categories and lists of available readings are the 
same for each of the four groups and for all view types.

More readings are available from the Information Groups dialog box when Expert 
mode is activated (see “Expert Mode” on page 93 for details).

Figure 4-39  Information Groups dialog box — Favorite Readings categories

The reading configuration is saved in an .rst file that is included by default in the .fps 
file (see “File Formats” on page 94 for details).
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4.9.2 Reading Examples

The following readings, illustrated in Figure 4-40 on page 137, provide useful 
numerical values for an indication’s amplitude and position within the inspected part:

A(r)
The amplitude (%) at the reference cursor position.

D(r)
The true indication depth (always between zero and the part thickness) at the 
reference cursor position.

T(r)
The thickness at the reference cursor position.

U(r)
The position of the reference cursor on the ultrasonic axis (expressed in time of 
flight [µs], half path [mm] or true depth [mm]).

Figure 4-40  Illustration of the A, D, T, and U readings

The following readings provide useful information for corrosion applications:

ML(r)
Material loss (%) at the reference cursor position

T(Zmin)
Minimum thickness inside the zone

S(ZMin)
Position of the minimum thickness inside the zone on the scan axis

I(Zmin)
Position of the minimum thickness inside the zone on the index axis

U

D

TA
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Figure 4-41  Example of corrosion readings

When you position the pointer over a reading, a tooltip appears, providing a useful 
definition of the reading (Figure 4-42 on page 138).

Figure 4-42  Example of a reading tooltip

You can display all readings in all views. However, a value only appears when the 
measurement can be computed in the view. For example, with an A-scan view, the 
amplitude value can be computed and displayed but not a zone value (Figure 4-43 on 
page 138).

Figure 4-43  Example of an empty reading

Zone

Empty reading
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4.9.3 Hiding or Showing Readings at the Top of a View

You can quickly hide or show readings configured to appear at the top of a view.

To hide or show a specific reading group at the top of a view

1. Select the view you want to modify.

2. On the component toolbar, select , , , or  to hide or show a specific 
reading group.

To hide or show all the readings at the top of a view

1. Right-click the title bar of the view.
2. In the shortcut menu, select or clear Show Info Group.

4.10 Working with Gates

The following steps describe how to configure the gates. This procedure must be 
independently performed for every group. For reference information on the Gates 
tab, refer to the FocusPC Advanced User’s Manual.

To define gates

1. On the component toolbar, click  (UT Settings).
2. If not already done, display an A-scan view on the active pane.
3. In the UT Settings dialog box, click the Gates tab and proceed as follows:

a) Position the vertical reference and measurement cursors on the ultrasonic 
axis, by double-clicking and double-right-clicking, so as to determine the 
starting position and length of the gate.

b) Position the horizontal reference cursor on the amplitude axis so as to 
determine the detection threshold level of gate 1.

c) Click Set Gate button.
d) Select the check box to the left of the corresponding gate to enable the creation 

of a data group, thereby enabling recording of the position and amplitude of 
the C-scan data.

e) Select the POS B - POS A check box to enable the creation of a data group 
monitoring the position difference between Gates A and B.
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4.10.1 Gate Adjustments

You can adjust the position and the width of a gate. In the A-scan, this is done by 
dragging-and-dropping a part of the gate line. The mouse pointer changes depending 
on where you click the gate line, and indicates the task that you can perform (Table 4 
on page 140).

You can precisely configure the gates by clicking , and then using the parameters 
on the Gates tab of the UT Settings dialog box (Figure 4-44 on page 140).

Figure 4-44  Gates tab of the UT Settings dialog box

4.10.2 Gate Synchronization

Synchronizing gates means that the start position of a gate depends on the start 
position of another gate. For example, when gate B has a start position of 10 mm and 
is synchronized with gate A, gate B starts 10 mm on the right of the start of gate A.

Table 4  Moving and resizing a gate using the mouse 

Task Pointer Action

To resize a gate Drag-and-drop the end of the gate line

To move a gate Drag-and-drop the middle part of the gate 
line

To move a gate vertically 
only

Press and hold the SHIFT key, and then 
drag-and-drop the middle part of the gate 
line

To move a gate 
horizontally only

Press and hold the CTRL key, and then 
drag-and-drop the middle part of the gate 
line
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Synchronizing gates is useful, for example, in an immersed inspection where the 
distance between the probe and the inspected part fluctuates in time. Using gate I to 
detect the interface echo, and then synchronizing gate A on gate I ensures that gate A 
always captures echoes from the same position range in the immersed inspected part.

You can only synchronize the position of a gate with the position of the previous gate. 
For example, gate A can only be synchronized with gate I, gate B can only be 
synchronized with gate A and so forth.

To synchronize a gate on another gate

1. To synchronize the A-scan starting position on gate I, set Synchro. to Echo (On I/) 
on the Digitizer tab of the UT Settings dialog box.

2. To synchronize other gates, set Link to the desired value on the Gates tab of the 
UT Settings dialog box.

When FocusPC acquires data, you can also specify a negative start position for a gate 
that is synchronized on another gate. This allows you to create anticausal or 
presynchronization detection. This feature is useful when you need to detect a weak 
echo appearing just before a strong echo. Presynchronization is possible because the 
FOCUS PX can generate up to 10 µs of signal prior to a gate. Note that while more 
than one pair of gates can use presynchronization, you cannot synchronize a gate to a 
synchronized gate that has a negative start position.

4.10.3 Gates in Analysis Mode

You can also adjust the gate position and size in Analysis mode. The modified data is 
saved in a companion file (.A01). You can easily come back to the original gate 
parameter values by right-clicking the title bar of the view and then selecting Restore 
Initial Gates on the shortcut menu.

In Analysis mode, when you move a gate on an A-scan or S-scan view while the 
ultrasonic axis is in true depth, the new gate position is calculated in true depth. 
However, when you move the a gate on an A-scan view while the ultrasonic axis is 
not in true depth, the new gate position is calculated in sound path.

NOTE
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In Analysis mode, when programmed in Half-Path mode, the gated zone on the 
S-scan is only for the current beam. The position of the gate limits are automatically 
adjusted on the S-scan when you change the current beam (Figure 4-45 on page 142).

Figure 4-45  Automatic adjustment of the S-scan gate position

4.10.4 Gates and Amplitude C-Scans

You can configure FocusPC to acquire data below the gate level by selecting the 
Always record amplitude in acquisition option in the Preferences menu. This option 
is activated (selected) by default. If this option is not selected, data under the gate 
level will not be acquired.

To configure FocusPC to show data below the gate level in acquisition

1. Select File > Preferences.
2. Under C-Scan on the General Settings tab, select the Always record amplitude 

in acquisition check box.

If you are in Analysis mode after moving the gate, you can also configure FocusPC to 
show this signal (Figure 4-46 on page 143) by repeating the above procedure and 
selecting the Always record amplitude in analysis check box.

Current beam Current beam
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Figure 4-46  Example of a C-scan with and without data below the gate

4.10.5 Gate Usage Example

A water immersion inspection is a good way to illustrate the use of multiple gates 
(Figure 4-47 on page 143). Position and size gate I over the area where you expect to 
find the echo from the part interface. Position gate A to cover the path inside the 
inspected part without detecting the entry and back wall echoes. Finally, position and 
size gate B over the area where you expect to find the back wall echo. In an immersion 
inspection, the distance between the probe and the part often fluctuates. To 
compensate for this fluctuation, the start position of gate A and gate B can be set to 
automatically change according to the position of the echo detected in gate I. This 
ensures that both gates constantly cover appropriate areas.

Figure 4-47  Example of gate usage in a water immersion inspection

Showing data below gate Not showing data below gate

Immersed probe

Gate I tracks the echo of the part
interface

Gate A tracks echoes of defects in the
part

Gate B tracks the echo of the back wall of
the part

Immersed part
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4.11 Working with the Alarms

The following procedure describes how to define the alarms. For reference 
information on the Alarms tab of the UT Settings dialog box, refer to the FocusPC 
Advanced User’s Manual.

To define the alarms

1. On the component toolbar, click  (UT Settings).
2. On the Alarms tab of the UT Settings dialog box, proceed as follows:

a) In the Output line list, select the alarm output line.
b) Under Conditions, define the alarm condition by selecting the appropriate 

options.
c) Repeat these steps for each alarm condition.
A set of indicators (Figure 4-48 on page 144) appears in the status bar 
representing the state of each alarm.

Figure 4-48  Alarm state indicators

4.12 Working with the Firing Sequencer

The Firing Sequencer dialog box is used to modify the order in which the ultrasonic 
beams are fired. For some applications, modifying the firing sequence can help reduce 
the effects of ghost echoes due to high recurrence.

For a phased array setup with multiple focal laws and channels, the firing repetition 
(recurrence) is very important to maximize the scanning speed without the presence 
of interference echoes. This can be critical for immersion techniques with the presence 
of signals coming from the water surface.

To activate the Firing Sequencer

1. On the component toolbar, click  (UT Settings).
2. In the UT Settings dialog box, select Interleaved.
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3. On the component toolbar, click the Firing Sequencer button ( ).
The Firing Sequencer dialog box appears, which contains the list of all beams 
included in the different groups.

Figure 4-49  Firing Sequencer (Interleave) dialog box

The following describes the buttons of the Firing Sequencer, which can be used to 
modify the firing order of the different beams.

Default
Brings the firing sequence order back to the default sequence (Group 1 - Beam 1, 
Group 1 -Beam 2, …, Group 2 - Beam 1, Group 2 - Beam 2, and so on).

Figure 4-50  Default button

2 Zones
Creates a firing sequence with interlacing pairs of beams within each group (see 
example in Figure 4-51 on page 146).
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Figure 4-51  Example of firing sequence with 2 Zones interlacing pairs

2 Z. All
Creates a firing sequence with interlacing pairs of beams within all groups (see 
example in Figure 4-52 on page 146).

Figure 4-52  Example of firing sequence with 2 Z. All interlacing pairs

Up
Moves the selected beam or group of beams up in the Firing sequences list.

Down
Moves the selected beam or group of beams down in the Firing sequences list.

Import
Allows you to import a .cfs file containing a firing sequence from a previously 
exported configuration.
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Export
Allows you to save the current firing sequence to a .cfs file.

4.13 Working with the Conditional A-Scan

When the Conditional A-scan feature is activated, A-scans are only recorded when an 
alarm has been triggered. This ensures that only A-scans of important areas are 
stored, which enables much larger areas to be scanned in a single inspection.

To set the conditional A-scan

1. Click the Digitizer tab of the UT Settings panel, and then select the Conditional 
check box. See Figure 4-53 on page 147.

Figure 4-53  Digitizer tab

2. Click the Alarms tab of the UT Settings dialog box, configure the alarms that will 
trigger A-scans to be recorded; four different alarms can be configured, all of 
which will have the same effect. See Figure 4-54 on page 147.
In the Count before Alarm box, you can set the number of consecutive times the 
alarm condition must be exceeded before the alarm is triggered.

Figure 4-54  Alarms tab
Setup Creation 147



DMTA-20092-01EN, Rev. G, September 2022
3. Click  to start an acquisition.
A-scans will only be recorded in the areas where an alarm was triggered, as seen 
in the following figures: Figure 4-55 on page 148 and Figure 4-56 on page 148.

Figure 4-55  Acquisition with full A-scan recording

Figure 4-56  Acquisition with conditional A-scan recording
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4.14 Working with CAF Groups

The CAF group is in most respects the same as a phased array group with two 
differences:

• Setup of the synchronization gate (required for the algorithm calculations).
• Activation of CAF and selection of the surface type.

The CAF algorithm is best used with a group of 32 elements. You must use the center 
elements of a CAF group with at least six beams around the center.

To set the CAF group

1. On the component toolbar, click  (UT Settings).
2. Set the digitizing range to see the targeted surface. If you are using a curved 

surface, ensure that the center of the curve is located on the middle elements of 
the probe. This will be critical for the algorithm to be as efficient as possible.

3. If you are using a surface that does not vary along the scan trajectory, you can use 
the same reference to set the beginning and end of the gate. If the surface varies 
along the scan line, use positions R1 and R2 (Figure 4-57 on page 149) as 
references for steps 4. on page 126 to 9. on page 153. In the illustration, the radius 
of the curvature is smaller at R1 than at R2.

Figure 4-57  R1 and R2 positions

When setting the gates, keep in mind the following:

R1 R2

TIP
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• The CAF algorithm works better when going from a flat to concave signal. Avoid 
convex signal to get good results.

• Remember that the CAF algorithm uses the data in the interface gate to 
recalculate delays.

• The images given as a reference given in this procedure are examples of a target 
with varying geometry. If the geometry does not change, use the same reference 
to set both the beginning and end of the interface gate.

• Set the gates wider than the signal as a tight interface gate will limit the efficiency 
of the algorithm.

4. Place the probe on the sample at the R1 position as in Figure 4-57 on page 149. If 
the sample shape does not vary, use any clean position on the sample.

5. Align the probe on the sample to get good concentricity. When the probe is 
concentric with a curved sample, the signal appears flat like in Figure 4-58 on 
page 151.

If the geometry is curved, remember to ensure that the middle elements of the probe 
are centered on the centerline of the curve. If the part has varying geometry, it might 
be best to move the probe to the R2 position to ensure it is centered on the curve and 
then return to R1 before continuing to the next step.

6. At that position, set the beginning of the interface gate (Figure 4-58 on page 151).

NOTE
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Figure 4-58  Setting the beginning of the interface gate

Only the position of the interface gate is relevant, not the height synchronization gate. 
It is recommended to set the gate threshold very low.

7. If the sample geometry varies, go to the R2 position (Figure 4-58 on page 151). Set 
the end of the interface gate (Figure 4-59 on page 152).

NOTE
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Figure 4-59  Setting the end of the interface gate

8. On the CAF tab (in UT Settings), select the CAF Enabled check box, and then 
select the surface type (Figure 4-60 on page 153).
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Figure 4-60  Selecting and enabling the CAF type

The “CAF Latched” status turns green when the algorithm has converged on the 
surface.

9. Select UT Settings > Digitizer, synchronize (Figure 4-61 on page 154) the CAF 
group with the algorithm, and then set the UT range.

NOTE
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Figure 4-61  Synchronized CAF
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5. Performing Acquisitions

To simplify scan configuration, FocusPC offers predefined scan types with typical 
values. You only have to enter the inspected area’s dimensions and set the parameters 
of your mechanical system. You can also modify the predefined scans as needed, or 
define custom scans.

5.1 Working with the Different Scan Types

FocusPC has several types of available scans: One-line scan, Free running, 
Bidirectional, Unidirectional, Helicoidal, Angular, and Custom.

These different scan types are explained in the following sections.

5.1.1 One-Line Scan

The One-line scan type is a linear scan. One position encoder is used to determine the 
position during the acquisition.

The linear scan (Figure 5-1 on page 156) is unidimensional and proceeds along a 
linear path. The only settings that must be provided are the limits along the scan axis 
and the spacing between acquisitions.
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Figure 5-1  Linear scan

Operation mode

The One-line scan operates as follows:

1. The scanner proceeds to the position set in the Scan: Start box of the Scan tab.
2. The scanner then moves on the scan axis to the position set in the Scan: Stop box, 

while performing data acquisition.
3. Data acquisition is performed at every interval set in the Scan: Resolution box.
4. The scan is finished when the scanner has reached the position set in the Scan: 

Stop box.

Description of the Scan tab

When you select One-line scan type, the Scan tab in the Scan and Mechanical 
Settings dialog box contains the set of options shown in Figure 5-2 on page 156.

Figure 5-2  Scan tab for the One-line scan type

The Scan tab for a One-line scan contains the same options as for a Bidirectional scan 
except that it does not include the settings for the index axis.

X
Probe Probe movement axis
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5.1.2 Free Running Scan

With the Free Running scan, data acquisition is performed at the rate specified in the 
PRF box of the Digitizer tab (UT Settings dialog box). For FocusPC, the data is 
recorded at only one position, at the origin of the scan and index axes.

Description of the Scan tab

When you select the Free Running scan type, the Scan tab contains no options or 
parameters (Figure 5-3 on page 157).

Figure 5-3  Scan tab for Free Running scan

5.1.3 Bidirectional Scan

The Bidirectional scan type is a bidimensional surface scan (also known as a raster 
scan) in which two encoders are used to determine the position on the scan and index 
axes during acquisition.

A surface scan uses two axes: (1) the scan axis, which is the mechanical axis of the 
scanning lines, and (2) the index axis, which is the mechanical axis of movement 
between the scanning lines. At the end of each scan along the scan axis, an increment 
is added to the position along the index axis. Data acquisition for bidirectional scans is 
carried out in both the forward and backward directions along the scan axis, as shown 
in Figure 5-4 on page 158.
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Figure 5-4  Bidirectional surface scan

The user must supply the limits of the inspection surface as well as the spacing 
between acquisitions. Figure 5-5 on page 159 shows the scan-axis and index-axis 
parameters in the reference system of the scanning mechanism.
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Figure 5-5  Reference system of the scanning mechanism

Operation mode

The Bidirectional scan operates as follows:

1. The scanner proceeds to the Scan: Start position set on the Scan tab.
2. The scanner proceeds to the Index: Start position set on the Scan tab.
3. The scanner then moves on the scan axis to the position set in the Scan: Stop box, 

while performing data acquisition.
4. Data acquisition is performed at every interval of the Scan: Resolution value set 

on the Scan tab.
5. The scanner moves on the index axis for the distance set in the Index: Resolution 

box.
6. The scanner moves to the Scan: Start position, while performing data acquisition.
7. The scanner moves on the index axis for the distance set in the Index: Resolution 

box.
8. The scanner then moves on the scan axis to the position set in the Scan: Stop box, 

while performing data acquisition.
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9. Steps 4 to 7 are repeated until the scanner has reached the position set in the 
Index: Stop box. Then, the scan is finished when the scanner has reached the 
position set in the Scan: Stop box (if the index axis has an odd number of steps), 
or when it has reached the Scan: Start position (if the index axis has an even 
number of steps).

5.1.4 Unidirectional Scan

The Unidirectional scan type is a bidimensional surface scan (also known as a raster 
scan) in which two encoders are used to determine the position during the 
acquisition.

A surface scan uses two axes: (1) the scan axis, which is the mechanical axis of the 
scanning lines, and (2) the index axis, which is the mechanical axis of movement 
between the scanning lines. At the end of each scan along the scan axis, an increment 
is added to the position along the index axis. Data acquisition for unidirectional scans 
is only carried out in one direction along the scan axis, as shown in Figure 5-6 on 
page 161. This type of scan is typically used with scanning mechanisms that have 
backlash (free play) in the scan direction.
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Figure 5-6  Unidirectional surface scan

The user must supply the limits of the inspection surface as well as the spacing 
between acquisitions (Figure 5-5 on page 159).

Operation mode

The Unidirectional scan operates as follows:

1. The scanner proceeds to the Scan: Start position set on the Scan tab.
2. The scanner proceeds to the Index: Start position set on the Scan tab.
3. The scanner then moves on the scan axis to the position set in the Scan: Stop box, 

while performing data acquisition.
4. Data acquisition is performed at every interval of the Scan: Resolution value set 

on the Scan tab.
5. The scanner returns to the Scan: Start position. No data acquisition is performed 

during this step.
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6. The scanner moves on the index axis for the distance set in the Index: Resolution 
box.

7. The scanner then moves on the scan axis to the position set in the Scan: Stop box, 
while performing data acquisition.

8. Steps 4 to 6 are repeated until the scanner has reached the position set in the 
Index: Stop box. Then, the scan is finished when the scanner has reached the 
position set in the Scan: Stop box.

Description of the Scan tab

When you select the Unidirectional scan type, the Scan tab contains the set of options 
shown in Figure 5-7 on page 162.

Figure 5-7  Scan tab for Unidirectional scan type

The Scan tab for a Unidirectional scan type contains the same options as for a 
Bidirectional scan type. For a description of these options, see “Bidirectional Scan” on 
page 157.

5.1.5 Helicoidal Scan

The Helicoidal scan type is similar to the Bidirectional scan. However, with this type 
of scan, the inspection mechanism performs a helicoidal movement around a cylinder.

A Helicoidal scan uses two axes: (1) the scan axis, which is the mechanical axis of the 
scanning lines (rotation), and (2) the index axis, which is the mechanical axis 
movement between the scanning lines (axial).
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Operation mode

In a Helicoidal scan, the two mechanical axes are driven by two motors controlled by 
an external control unit or axes of a manually driven scanner.

The Helicoidal scan type operates as follows:

1. The scanner proceeds to the position set in the Scan: Start and Index: Start boxes 
of the Scan tab.

2. The scanner then moves on the scan axis and index axis to the position set in the 
Scan: Stop and Index: Stop boxes, while performing data acquisition. There is 
simultaneous motion on both axes.

3. Data acquisition is performed at every interval of the Scan: Resolution value set 
on the Scan tab.

4. In a Helicoidal scan, the scan axis is projected along the circumference of the 
cylinder. The Scan: Start and Scan: Stop values refer to the circumference origin 
point (0), in distance units or angular units.

5. A signal or a modulo can be used to reset the scan-axis encoder to the Scan: Start 
value after each complete rotation.

6. The scan is finished when the scanner has reached the position set in the Index: 
Stop box.

Description of the Scan tab

When you select the Helicoidal scan type, the Scan tab contains the set of options 
shown in Figure 5-8 on page 163.

Figure 5-8  Scan tab for Helicoidal scan
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The Scan tab for a Helicoidal scan type contains the same options as for a 
Bidirectional scan type. For a description of these options, see “Bidirectional Scan” on 
page 157. This tab also contains three additional option buttons and one additional 
parameter:

Deg/Index
This box defines the distance along the scan axis (in degrees) that is completed for 
each index increment. The Index axis inspection speed value is then deduced 
from this value, the Scan axis inspection speed, and the Index resolution.

The chosen Deg/Index value is usually slightly larger than 360 degrees, to obtain 
sufficient overlap between adjacent Helicoidal scan lines.

Scan reset
Click one of these option buttons to select one of the options used to reset the 
scan-axis encoder to position zero:

None: scan-axis encoder is never reset.

Modulo: scan-axis encoder is reset to position zero when a maximum value 
(modulo) corresponding to the Scan: Stop value is reached.

Top Turn: a synchronization signal is used to reset the scan-axis encoder to the 
Scan: Start value.

5.1.6 Angular Scan

The Angular scan type is a two-dimensional surface scan, where the scan and index 
axes do not correspond to the orientation of the mechanical axes, such as in the 
Bidirectional and Unidirectional scans. Instead, the scan and index lines form a 
certain angle with the orientation of the mechanical axes (Figure 5-9 on page 165). 
Two position encoders are used to determine the position during the acquisition.

A surface scan uses two axes: (1) the scan axis, which is the mechanical axis of the 
scanning lines, and (2) the index axis, which is the mechanical axis displacement 
between the scanning lines. At the end of each scan along the scan axis, an increment 
is added to the position along the index axis. With this scan type, the mechanical axes 
work together in such a way as to produce the desired scanning pattern. Data 
acquisition for angular scans is carried out in both the forward and backward 
directions along the scan axis.
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Figure 5-9  Angular surface scan

Operation mode

The Angular scan type operates as follows:

1. The scanner proceeds to the position set in the Scan: Start and Index: Start boxes 
of the Scan tab.

2. The scanner then moves on the scan axis, according to the specified angle, to the 
position set in the Scan: Stop box, while performing data acquisition.

3. Data acquisition is performed at every interval of the Scan: Resolution value set 
on the Scan tab.

4. The scanner moves on the index axis, according to the specified angle, for the 
distance set in the Index: Resolution box.
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5. The scanner moves on the scan axis, according to the specified angle, to the Scan: 
Start position, while performing data acquisition.

6. The scanner moves on the index axis, according to the specified angle, for the 
distance set in the Index: Resolution box.

7. The scanner then moves on the scan axis, still according to the specified angle, to 
the position set in the Scan: Stop box, while performing data acquisition.

8. Steps 4 to 7 are repeated until the scanner has reached the position set in the 
Index: Stop box. Then, the scan is finished when the scanner has reached the 
position set in the Scan: Stop box (if the index axis has an odd number of steps), 
or when it has reached the Scan: Start position (if the index axis has an even 
number of steps).

Description of the Scan tab

When you select the Angular scan type, the Scan tab contains the set of options 
shown in Figure 5-10 on page 166.

Figure 5-10  Scan tab for Angular scan type

The Scan tab for an Angular scan type contains the same options as for a 
Bidirectional scan type. For a description of these options, see “Bidirectional Scan” on 
page 157. This tab also contains an additional parameter, which is required for this 
scan type:

Angle
This box is used to set the angle that the scan line forms with the orientation of the 
mechanical axis.
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5.1.7 Custom Scan

Selecting the Custom scan type automatically opens the Load Custom Program File 
dialog box (Figure 5-11 on page 167). This dialog box is used to select and load a 
special type of scan predefined in a .gal file.

Figure 5-11  Load custom program file dialog box

5.2 Working with Encoders

You can use one or more encoders in your setup to measure the position of the probe 
on the scanned area.

FocusPC supports different types of encoders (see “Encoder Types” on page 167).

You need to calibrate each encoder (see “Calibrating an Encoder” on page 170).

5.2.1 Encoder Types

FocusPC supports various types of encoders. You can select the encoder type on the 
Encoders tab of the Scan and Mechanical Settings dialog box (Figure 5-12 on 
page 168).
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Figure 5-12  Selecting the encoder type on the Encoders tab

Each encoder input on your acquisition unit has two channels, A and B, enabling a 
dual-channel encoder for a quadrature reading of the resolution.

The available encoder types are as follows:

Clock Dir
Select this option when you use a stepper controller and its documentation 
specifies that the position output signal is a clock/direction type (5 V pulse for the 
position/speed and 5 V signal for the direction).

Quadrature
Select this option when the attached encoder (5V TTL output) is a dual-channel 
output encoder. The channels are generally named A and B. When the encoder is 
rotating clockwise (from left to right in Figure 5-13 on page 169), channel B 
follows channel A with a 90-degree delay. When the encoder is rotating 
counterclockwise, channel A follows channel B with a 90-degree delay. In this 
way you can determine if the rotation is clockwise or counterclockwise. The 
decoder counts one step each time it detects a rising or a falling edge on 
channel A or channel B. This means that if the real encoder resolution is 
1000 steps/revolution, the final resolution with the quadrature reading is 
4000 steps/revolution.
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Figure 5-13  Quadrature and normal reading of the resolution

Up
The decoder only reads channel A and increments the counter even if the encoder 
is turning counterclockwise. The final resolution is the real encoder resolution.

Down
The decoder only reads channel A and decrements the counter even if the encoder 
is turning clockwise. The final resolution is the real encoder resolution.

Clock/Dir Up
The decoder only reads channel A and increments the counter. When the signal of 
channel B (direction) is high, the acquisition stops to prevent overwriting the data 
while you move the probe back and the counter is decremented.

Clock/Dir Down
The decoder only reads channel A and decrements the counter. When the signal 
of channel B (Dir) is high, the acquisition stops to prevent overwriting the data 
while you move the probe back and the counter is incremented.

Quad Up
The decoder reads channel A and channel B in quadrature mode (4 times the 
encoder resolution) and increments the counter when the encoder rotates 
clockwise. When the encoder rotates counterclockwise, the acquisition stops to 
prevent overwriting the data and the counter decrements.

Quad Down
The decoder reads channel A and channel B in quadrature mode (4 times the 
encoder resolution) and decrements the counter when the encoder rotates 
counterclockwise. When the encoder rotates clockwise, the acquisition stops to 
prevent overwriting the data and the counter increments.

Channel A

Channel B

Quadrature reading

Normal reading
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5.2.2 Calibrating an Encoder

You need to calibrate an encoder to validate, fine-tune, or determine its resolution. 
The resolution of an encoder is the number of steps corresponding to a traveled 
distance of 1 mm or 1 in., or 1 degree.

Perform the following procedure for each encoder that you are using.

To calibrate an encoder

1. On the component toolbar, click the Scan and Mechanical Settings button ( ).
2. In the Scan and Mechanical Settings dialog box, click the Scan tab, and then 

perform the following tasks:
a) In the Type box, select the appropriate scan type for your application. Do not 

select Free running as this type does not support encoders.
b) In the Unit box, select the appropriate linear or angular units.

3. On the Encoders tab (Figure 5-14 on page 170), proceed as follows:
a) In the Type box, select the type of your encoder (see “Encoder Types” on 

page 167).
b) Click Calibrate.

Figure 5-14  Encoders tab of the Scan and Mechanical Settings dialog box for an 
Encoded - 2 axis scan type

4. While in the Calibration of Encoder dialog box (see the example shown in 
Figure 5-15 on page 171), proceed as follows:
a) Optionally, move the required encoder (or the mechanical parts attached to 

the encoder) to a known position on the axis, and then click Set.
This operation sets the current position to the value of the Preset value box 
that has been specified on the Scan tab.
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b) Click Set Begin.
c) Move the encoder over a defined distance on the axis in the direction that is 

considered positive. Use the Movement buttons to move the scanner.
d) Click Set End.
e) In the Set Distance box, enter the traveled distance, and then click Set 

Distance.
The resulting encoder resolution appears in the Calculated resolution box.

f) When needed, click Clear to reset the parameter values, and then return to 
step 4.a.

g) Click OK to apply the calculated encoder resolution.

Figure 5-15  Calibration of Encoder dialog box for encoder 1 on the scan axis

5.3 Defining the Automatic Savings Options

On the Options tab of the Scan and Mechanical Settings dialog box, you can use the 
File Naming Options section to configure the way the data files will be saved at the 
end of the inspection (Figure 5-16 on page 172).
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Figure 5-16  File Naming Options dialog box

To configure the automatic saving options

1. Set Directory to the folder where the files are to be saved.
2. Set Root Name to the name of the data files to be saved.

— The @ character inserts a counter that will automatically increase the file 
name by one. For example, entering test@ will generate test0.fpd, test1.fpd, 
test2.fpd, and so on.

— The # character adds the desired number of digits for repeats. For example, 
typing test@## will generate test000.fpd, test100.fpd, test200.fpd, and so on.

— If a file exists (for example, test000.fpd) then the new file will be saved under 
the following name: test001.fpd (first repeat of the test000.fpd file name).

3. Set Counter value to configure the start value of the counter that is inserted in the 
file name with the @ character.

4. Select the Automatic, Prompt, or Confirm saving mode.
— The Automatic mode will save the data files without asking for a 

confirmation.
— The Prompt mode will deactivate the automatic file naming and ask you to 

enter the data file name at the end of every acquisition.
— The Confirm mode will ask you to confirm the file name defined in the Root 

name before saving the data file.
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6. Basic Analysis Using FocusPC

After the data acquisition is complete, FocusPC can be used to analyze the resulting 
data files. This section describes the basic analysis in FocusPC, demonstrating how 
you can manage data files to create simple and convenient reports making the 
inspection results easy to understand.

6.1 Opening Data Files in FocusPC

This section describes how to open FocusPC data files and merge data files in order to 
combine multiple inspection data to a single file that can then be analyzed and 
described in a simple report.

The Open dialog box (Figure 6-1 on page 174) is used to select and load an ultrasonic 
data file as well as the other data types that can be linked to this file.

To open a FocusPC data file

1. In the main menu, click File > Open.
2. Make sure that Data Files is selected in the upper-left section of the Open dialog 

box.
3. Select the appropriate File Content and Processing options (see the descriptions 

below for more information on these options).
4. Click Open.
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Figure 6-1  Open dialog box

The File Content and Processing areas of the Open dialog box contain the following 
options:

File Content
You can use the check boxes under File Content to select the appropriate 
associated files (for a description of the file types, see “File Formats” on page 94).

For example, an .fpd data file can be saved with an .A01 data file resulting from 
analysis processing. You can then either open the original data alone (.fpd file), or 
open the original data along with the data modified in analysis (.fpd and .A01 
files). The principle of associated files allows the original data to remain intact 
after the data file is saved.

Only the file types that are associated with the .fpd file when saving the data can 
be selected. The dimmed file types are not available.

Processing
You can use the check boxes under Processing to select optional calculations to be 
performed on the file to be opened. After opening the file, FocusPC calculates the 
selected processing options and adds the associated data groups to the file.
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— The Merge all check box performs the same calculations as the corresponding 

toolbar command ( ).

— The Merge by group check box performs the same calculations as the 

corresponding toolbar command ( ).

6.2 Working with the Indication Table and Report Component

The indication table is a key feature of FocusPC (Figure 6-2 on page 175). Use the 
indication table to gather flaw indication information and to create an HTML report. 
The following are basic steps for using the indication table:

• Use the cursors and the Zone tool to highlight an indication.
• Open the indication table and add an indication.
• Add comments and extra readings to the table.
• Customize the report.
• Preview and produce the HTML report.

Figure 6-2  Indication table

FocusPC automatically saves the indication table in the display setup file (.RST) and 
automatically saves the numerical reading indication information contained in the 
indication table in an attribute file (.R01).

NOTE
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6.2.1 Adding an Indication to the Indication Table

Use the Zone tool and the indication table to quickly select the area corresponding to 
an indication and create a record for the indication.

You can customize the sizing settings in the Preferences dialog box on the General 
Settings tab under Flaw-Sizing Settings.

To add an indication to the indication table

1. Select a layout with views that best illustrate the indications in the part (see the 
example shown in Figure 6-3 on page 176).

Figure 6-3  Example of the indication table, the cursors, and the Zone tool used to 
document an indication

TIP
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2. On the component toolbar, click the Indication Table button ( ) to display the 
Indication Table dialog box.
The first line of the table indicates the current value of the selected readings.

3. Position the Reference and Measurement cursors to mark the indication.
4. Using the Zone tool, draw a zone around a flaw indication.
5. In the Indication Table dialog box, select a predefined reading category 

(Figure 6-4 on page 177) to determine the readings that appear in the table.

Figure 6-4  Selecting a predefined reading category in the indication table

You can select a different reading category for each indication table entry. The 
indication image is a snap shot of the data display views taken when you click 

. When you want to put the emphasis on the defects characteristics, 

configure the views accordingly before clicking .

6. In the Indication Table dialog box, click .
The selected flaw indication is added to the Indication Table list and a red 
marking rectangle labeled with the indication number appears on the view.

7. As needed, repeat steps 3 to 6, to mark other indications.
8. You can add a comment to an indication:

a) In the Indication Table dialog box, select the indication to which you want to 
add a comment by clicking the corresponding line in the table.

b) Click Additional Info.
c) In the Custom Readings dialog box that appears (Figure 6-5 on page 178), 

type your comment for that indication in the Comment box.

TIP
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The comment then appears in the Comments section of the report for the 
selected indication.

Figure 6-5  Adding a comment and an additional reading to an indication

9. You can also include additional readings in the indication table (Figure 6-5 on 
page 178):
a) In the Indication Table dialog box, select the line for the Entry# = Auto 

indication.

b) In the Custom Readings dialog box, click .
c) In the Readings Selection dialog box that appears, select the check box of one 

or more readings that you want to add to the selected indication, and then 
click OK.
The selected readings appear in the Custom Readings dialog box, under 
Additional readings.
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Additional readings appear only for new indications, not for those already entered in 
the indication table.

6.2.2 Producing an Ultrasonic Inspection Report

When you have completed the indication analysis using the indication table, you can 
produce an HTML ultrasonic inspection report from the Indication Table dialog box. 
This report includes the following elements for each defined group of the 
configuration:

• Setup information
• Inspected part information
• Scanned area information
• Content of the indication table
• Views for each entry of the indication table
• Customized information

To produce an ultrasonic inspection report

1. Gather indication information in the indication table (see “Adding an Indication 
to the Indication Table” on page 176).

2. In the Indication Table dialog box, click General info to open the General 
Information dialog box, and customize the HTML report (Figure 6-6 on 
page 180):
a) In the Report Header box, type your report header information.

The text appears at the beginning of the report (Figure 6-7 on page 180).
b) In the Footnote box, type your report footnote information.

The text appears in the Notes section at the end of the report (Figure 6-8 on 
page 181).

c) Click .
d) Type the custom information label in the Field box and the corresponding 

value in the Value box.

NOTE
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The added user fields appear in the second section from the top of the report 
(Figure 6-7 on page 180).

e) Click OK.

Figure 6-6  Example of the General Information dialog box

Figure 6-7  Example of a report header and user fields

Report header text

User field text
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Figure 6-8  Example of a report footer

3. Back in the Indication Table dialog box, click Preview.
The HTML report appears in your Internet browser.

4. Review the report.
5. In the Indication Table dialog box, click Print.
6. In the Print dialog box, select the printer, and then click Print to print the report.

6.2.3 Changing the Logo in the Inspection Report

The Evident logo appears by default at the top of the inspection report. You can 
change the logo.

Ensure that you change the logo before creating the report. Otherwise, the old image 
will appear in the report. You then need to delete the report file (.r01) and add the 
indications again.

To change the logo appearing at the top of the inspection report

1. Create a small image of the logo that you want to see at the top of the inspection 
report.

Report footer text

TIP
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Use a logo image that is about the same size as the Evident logo image (200 pixels 
wide by 38 pixels high).

2. In the [Installation Folder]\FocusPCnnn folder, proceed as follows:
a) If you do not want to lose the Evident logo file, rename the logo.jpg file to 

Evident_logo.jpg.
b) Save the image of your logo in the JPEG format using the logo.jpg file name.
Your logo appears at the top of the next inspection report that you generate.

For more information on the advanced features of this software and detailed menu 
descriptions, refer to the FocusPC Advanced User’s Manual.

TIP

NOTE
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